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Overview
How to use this document

Thank you for choosing Ultimus!

This document outlines how to install either Ultimus Adaptive BPM Suite 8.3 or Ultimus Adaptive BPM 
Suite 8.3 SP2. Refer to the following sections to determine how to use this document:

• Installing Ultimus Adaptive BPM Suite 8.3 into a new Ultimus BPM environment

• Upgrading to Ultimus Adaptive BPM Suite 8.3 into an existing Ultimus Adaptive BPM 8.0 
through 8.2 environment

• Upgrading to Ultimus Adaptive BPM Suite 8.3 SP2 from Ultimus Adaptive BPM Suite 8.3 or 
Ultimus Adaptive BPM Suite 8.3 SP1

Installing Ultimus Adaptive BPM Suite 8.3 into a new Ultimus BPM 
environment

If you are installing Ultimus Adaptive BPM Suite 8.3 into a new Ultimus BPM environment, refer 
to the following sections throughout this document:

• Overview

a. Assumptions about the reader

b. Three important considerations

c. Major components of the Ultimus Adaptive BPM Suite

d. Network load balancing

• Chapter 1, Preparing to install Ultimus Adaptive BPM Suite 8.3

• Chapter 2, Installing Ultimus Adaptive BPM Suite 8.3 or 8.3 SP2

• Chapter 3, Post-installation configuration

Installation Guide should be used in conjunction with the following documents for Ultimus 
Adaptive BPM Suite 8.3:

• Migration Guide: This document outlines how to migrate from Ultimus (Adaptive) BPM 
Suite 6.x, 7.x, or 8.x to Ultimus Adaptive BPM Suite 8.3.

• Known Issues: This document outlines all known issues pertaining to Ultimus Adaptive 
BPM Suite 8.3. This document is especially helpful for customers who are planning to 
upgrade to Ultimus Adaptive BPM Suite 8.3.

http://www.ultimus.com/
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• Release Notes: This document outlines issues from previous Ultimus Adaptive BPM Suite 
releases which are now resolved in Ultimus Adaptive BPM Suite 8.3.

• Using the Process Migration Tool: This document outlines how to use the Process 
Migration Tool. This tool may be used to help convert version 6.x and 7.x business processes 
for use in version 8.3.

• Configuration Guide: This reference guide serves both novice and experienced Ultimus 
Adaptive BPM Suite users to specific configuration procedures and processes to particular 
modules within the Ultimus Adaptive BPM Suite version 8.3. This reference guide is 
modular, allowing the reader to find specific information to quickly and easily configure 
Ultimus Adaptive BPM Suite 8.3.

• Ultimus supported and discontinued technologies supplement: This document provides 
guidelines on the support for Ultimus and third-party vendor technologies. This document 
also lists information on the discontinuation of key internal Ultimus technologies.

These documents may be viewed at http://www.ultimussupport.com/.

Upgrading to Ultimus Adaptive BPM Suite 8.3 into an existing 
Ultimus Adaptive BPM 8.0 through 8.2 environment

If you are upgrading Ultimus Adaptive BPM Suite 8.3 from Ultimus Adaptive BPM Suite 8.0 
through 8.2, refer to the following sections throughout this document:

• Overview

a. Assumptions about the reader

b. Three important considerations

c. Major components of the Ultimus Adaptive BPM Suite

d. Network load balancing

• Chapter 1, Preparing to install Ultimus Adaptive BPM Suite 8.3

• Chapter 2, Installing Ultimus Adaptive BPM Suite 8.3 or 8.3 SP2

• Chapter 3, Post-installation configuration

Installation Guide should be used in conjunction with the following documents for Ultimus 
Adaptive BPM Suite 8.3:

• Migration Guide: This document outlines how to migrate from Ultimus (Adaptive) BPM 
Suite 6.x, 7.x, or 8.x to Ultimus Adaptive BPM Suite 8.3.

• Known Issues: This document outlines all known issues pertaining to Ultimus Adaptive 
BPM Suite 8.3. This document is especially helpful for customers who are planning to 
upgrade to Ultimus Adaptive BPM Suite 8.3.

• Release Notes: This document outlines issues from previous Ultimus Adaptive BPM Suite 
releases which are now resolved in Ultimus Adaptive BPM Suite 8.3.

http://www.ultimussupport.com/
http://www.ultimus.com/


vi Installation Guide ultimus.com

• Using the Process Migration Tool: This document outlines how to use the Process 
Migration Tool. This tool may be used to help convert version 6.x and 7.x business processes 
for use in version 8.3.

• Configuration Guide: This reference guide serves both novice and experienced Ultimus 
Adaptive BPM Suite users to specific configuration procedures and processes to particular 
modules within the Ultimus Adaptive BPM Suite version 8.3. This reference guide is 
modular, allowing the reader to find specific information to quickly and easily configure 
Ultimus Adaptive BPM Suite 8.3.

• Ultimus supported and discontinued technologies supplement: This document provides 
guidelines on the support for Ultimus and third-party vendor technologies. This document 
also lists information on the discontinuation of key internal Ultimus technologies.

These documents may be viewed at http://www.ultimussupport.com/.

Upgrading to Ultimus Adaptive BPM Suite 8.3 SP2 from Ultimus 
Adaptive BPM Suite 8.3 or Ultimus Adaptive BPM Suite 8.3 SP1

If you are upgrading Ultimus Adaptive BPM Suite 8.3 SP2 from Ultimus Adaptive BPM Suite 8.3 
or Ultimus Adaptive BPM Suite 8.3 SP1, refer to the following sections throughout this document: 
Installing Ultimus Adaptive BPM Suite 8.3 SP2.

Assumptions about the reader

While this document attempts to make the Ultimus Adaptive BPM Suite installation process as easy as 
possible, this document makes the following assumptions about the reader:

• The person installing any component of the Ultimus Adaptive BPM Suite (referred henceforth 
as “the reader”) is a novice to the Ultimus BPM experience. This document aims to make your 
first experience with the Ultimus Adaptive BPM Suite as easy as possible. The reader may not 
even be an individual who intends to use Ultimus Adaptive BPM Suite, but rather installs 
software as part of their job function in your organization.

• The reader is a network administrator or IT professional: an individual who oversees the 
installation (and possibly deployment and maintenance) of enterprise-class software.

• The reader is an experienced Microsoft Windows user who is familiar with working within the 
Microsoft Windows environment. This applies to any Windows operating system that Ultimus 
Adaptive BPM Suite supports. The reader has Administrator rights on all computers within the 
organization and can make changes to LAN security and configuration.

• The reader is knowledgeable in configuring any hardware or software firewall tools the 
organization has in place. Communication among Ultimus modules in a firewall-enabled 
environment is incumbent upon the network administrator to properly configure. Ultimus 
modules communicate over HTTP and do not require any additional settings in a firewall 
environment. However, there may be certain firewall restrictions that may hinder the ability for 
Ultimus to operate.

http://www.ultimus.com/
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Contacting Ultimus

Ultimus is always striving to improve its product and support services. Furthermore, Ultimus offers a 
number of ways to find answers or to submit feedback.

You may use the following ways to find answers to your Ultimus-related questions or to submit feedback 
to Ultimus:

• Ultimus Customer Portal: At the Ultimus Customer Portal, you can access technical experts to 
resolve your technical issues, use the KnowledgeBase to get answers to common and specific 
questions, and download the latest product builds and documentation. You can reach Ultimus 
Support at: https://www.ultimussupport.com/.

• Ultimus Education: Ultimus Education provides technical training and certification on the 
latest Ultimus BPM Suite to ensure you possess up-to-date knowledge of the latest product 
releases. Ultimus Enterprise Integration Kit (EIK) training is provided on an as-needed basis. 
For more information, contact training@ultimus.com.

• Product enhancement: Ultimus strives to improve our product. If you would like to submit a 
product enhancement or feature concept, go to the Ultimus Customer Portal at: 
https://www.ultimussupport.com and follow the “Ideas” link in the upper area.

• Documentation feedback: Ultimus strives to improve technical documentation and online help. 
If you would like to submit documentation feedback, contact documents@ultimus.com.

Conventions used in this document

The following conventions are used throughout this document:

bold Bold text denotes items that you must select or click on in an application, such as 
menu options, dialog box options, and dialog box output. Bold text is also used to 
designate labels within table columns.

italic Italic text denotes variables, emphasis, and document, chapter, and section titles. 
This also denotes text that is a place holder for a word or value that you must 
supply.

monospace Text in this font denotes text or characters that you should input to an application, 
application output, sections of code, programming examples, and syntax 
examples. This is also used for the proper names of disk drives, paths, directories, 
device names, file names, file extensions, code excerpts, and hyperlinks.

monospace italic Italic text in this font denotes text that is a placeholder for text or value(s) that you 
must supply.

» The » symbol leads you through nested Start menu options, application menu 
options, and dialog box options to a final action. For example, the sequence 
File»Page Setup»Printer... directs you to pull down the File menu, select the 
Page Setup item, then select Printer... from the dialog box.

https://www.ultimussupport.com/
mailto:training@ultimus.com
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Three important considerations

There are three important considerations before the Ultimus Adaptive BPM Suite can be installed and 
deployed:

• Identify the computer which is to host Ultimus BPM Server.

• Confirm Internet Information Server (IIS) and Component Services (COM+) are installed on this 
computer.

• Configure particular Windows rights to the Windows account being used for Ultimus Adaptive 
BPM Suite installation.

These are described below.

Identify the computer which is to host Ultimus BPM Server

The computer hosting Ultimus BPM Server plays a central role in the Ultimus BPM experience. 
The computer hosting Ultimus BPM Server must meet the computer requirements outlined in 
Table 1, General hardware requirements for the Ultimus Adaptive BPM Suite (page 18), Table 2, 
Ultimus BPM Server hardware requirements (page 19), and Table 8, Ultimus BPM Server software 
requirements (page 21) in the Preparing to install Ultimus Adaptive BPM Suite 8.3 section.

Caution: Due to Microsoft limitations, the name of the computer hosting your Ultimus 
BPM Server should include only alpha-numeric characters. Refer to SPR06483 in 
the Ultimus KnowledgeBase for details.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid 
specific application errors, data loss, or system crash.

This icon denotes a warning, which advises you of precautions to take to avoid 
damaging computer hardware or losing computer data.

http://www.ultimus.com/
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Required operating system components/roles to be installed

Depending on the operating system will be used to host Ultimus BPM Server, specific Windows 
Server 2003 components (or specific Windows Server 2008 (R2) roles and related role services) 
must be installed prior to installing Ultimus Adaptive BPM Suite. For more information about which 
components or roles must be installed prior to installing Ultimus Adaptive BPM Suite, refer to 
Required operating system components/roles to be installed section.

Configure the Ultimus Windows account

To properly install Ultimus BPM Server, a Windows user account (called the “Ultimus Windows 
account” in this document) must already exist on this computer with particular Windows rights. 
This Windows user account information will be requested when installing Ultimus BPM Server. 
Further details about configuring the Ultimus Windows account can be found in the Identifying the 
Ultimus Windows account section.

Major components of the Ultimus Adaptive BPM Suite

A key to understanding how to best install the Ultimus Adaptive BPM Suite in your environment is to 
consider some of its major components:

• Ultimus BPM Server

• Ultimus System Administrator

• Ultimus Process Administrator

• Ultimus BPM Database

• Ultimus Organization Charts

• Ultimus Business Organization Database

• Ultimus BPM Studio

• Ultimus BPM Studio Repository

• Ultimus Director

• Ultimus FloStation

• Ultimus Reports

• Ultimus Process Designer

Each of these components may be installed separately (on separate computers), or on the same computer. 
Please note, however, that different components have varying minimum hardware and software 
requirements. Refer to the Verifying computer hardware and software requirements section for 
information in this regard.

Prior to installing the same components of the Ultimus Adaptive BPM Suite on multiple computers, 
please consult your sales contract to ensure that you are not exceeding any license agreements between 
your company and Ultimus, Inc. If you have any questions about the number of installations to which 

http://www.ultimus.com/
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you are entitled for any of the major components, please contact your regional Ultimus Sales 
Representative.

A description of the major components, or modules, of the Ultimus Adaptive BPM Suite is offered 
below.

Ultimus BPM Server

Ultimus BPM Server is the module on which the Ultimus engine and the Ultimus BPM service run. 
It is the environment to which business processes are deployed when they are published through 
Ultimus BPM Studio. In order to ensure maximum performance, efficiency, and usability, Ultimus 
BPM Server should be installed on a dedicated server.

By default, installing only Ultimus BPM Server does not install any Ultimus module shortcuts into 
the Windows Start Menu. If you wish to have any additional selections available on the computer 
which hosts Ultimus BPM Server, then you need to install specific modules in addition to installing 
the Ultimus BPM Server.

For minimum computer requirements to Ultimus BPM Server, refer to Table 1, General hardware 
requirements for the Ultimus Adaptive BPM Suite, Table 2, Ultimus BPM Server hardware 
requirements, and Table 8, Ultimus BPM Server software requirements.

Ultimus System Administrator

Ultimus System Administrator is one of three modules used to configure the Ultimus BPM 
environment. Ultimus System Administrator should be installed on any computer used to administer 
Ultimus BPM Server. Along with Ultimus Process Administrator, and Ultimus Organization Charts, 
these three modules are used to control and configure Ultimus BPM Server.

Ultimus System Administrator provides powerful, centralized capabilities and conveniences for 
managing and administering Ultimus BPM Server. It also provides the tools necessary to manage 
exceptions in the system, applications, and in business processes.

For minimum computer requirements to Ultimus System Administrator, refer to Table 5, Ultimus 
clients, Ultimus System Administrator, Ultimus Process Administrator, Ultimus BPM Studio 
Configuration, Ultimus Reports, Ultimus Director, and Ultimus Organization Charts hardware 
requirements, and Table 14, Ultimus System Administrator software requirements.

Ultimus Process Administrator

Ultimus Process Administrator provides powerful capabilities for managing and administering 
processes for small or large organizations. It includes an advanced user interface to manage and 
configure associates, views, and workload-related capabilities. While Ultimus System 
Administrator is more often used by IT, Ultimus Process Administrator is used by Process Owners 
and Process Experts.

For minimum computer requirements to Ultimus Process Administrator, refer to Table 5, Ultimus 
clients, Ultimus System Administrator, Ultimus Process Administrator, Ultimus BPM Studio 

http://www.ultimus.com/
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Configuration, Ultimus Reports, Ultimus Director, and Ultimus Organization Charts hardware 
requirements and Table 15, Ultimus Process Administrator software requirements.

Ultimus BPM Database

Ultimus BPM Database is not an installed Ultimus module. It must be set up and configured using 
a supported database (detailed information about configuring supported databases is offered in the 
Preparing to install Ultimus Adaptive BPM Suite 8.3 section). Ultimus BPM Database is an essential 
part of the Ultimus BPM environment.

In a small implementation, Ultimus BPM Database can be installed on the same computer as 
Ultimus BPM Server. However, regardless of the implementation size, it is recommended that a 
dedicated database server be used.

Perhaps the greatest resources that can be dedicated to Ultimus BPM Database are hard drive disk 
space, memory, and processor speed. Running out of hard drive disk space can adversely affect 
Ultimus Adaptive BPM Suite’s ability to function, and such dysfunction can reveal itself in any 
number of ways within the Ultimus BPM environment. Additionally, processor speed and memory 
can limit the efficiency of the database server to return requests, therefore reducing the efficiency 
and performance of Ultimus BPM Server.

For minimum computer requirements to Ultimus BPM Database, refer to Table 4, Ultimus BPM 
Studio Repository, Ultimus BPM Database, and Ultimus Business Organization Database hardware 
requirements and Table 10, Ultimus BPM Studio Repository, Ultimus BPM Database, Ultimus 
Business Organization Database, and Ultimus BPM Studio Server software requirements.

Ultimus Organization Charts

Ultimus Organization Charts lets you graphically design a business chart representing the reporting 
structure of your organization and its divisions, departments, and sections. Once a business chart has 
been created, business processes become aware of the roles, reporting relationships, and groups in 
the organization. In short, Ultimus Organization Charts lets you design business processes that can 
route tasks intelligently.

For minimum computer requirements to Ultimus Organization Charts, refer to Table 5, Ultimus 
clients, Ultimus System Administrator, Ultimus Process Administrator, Ultimus BPM Studio 
Configuration, Ultimus Reports, Ultimus Director, and Ultimus Organization Charts hardware 
requirements and Table 16, Ultimus Organization Charts software requirements.

Ultimus Business Organization Database

Similarly to Ultimus BPM Database, Ultimus Business Organization Database is not an installed 
Ultimus module. It must be set up and configured using a supported database (detailed information 
about configuring supported databases is offered in the Preparing to install Ultimus Adaptive BPM 
Suite 8.3 section). Ultimus Business Organization Database is the data repository for business charts 
created in Ultimus Organization Charts. Similarly to Ultimus BPM Database, a dedicated database 
server should host Ultimus Business Organization Database. However, the same database server 
used to host Ultimus BPM Database may also host Ultimus Business Organization Database. In 
addition, Ultimus Business Organization Database can be created within Ultimus BPM Database, 

http://www.ultimus.com/
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but it is recommended to use a separate dedicated database for Ultimus Business Organization 
Database. In a small implementation, Ultimus Organization Database can be installed on the same 
computer as Ultimus BPM Server. However, regardless of the implementation size, it is 
recommended that a dedicated database server be used.

For minimum computer requirements to Ultimus Business Organization Database, refer to Table 4, 
Ultimus BPM Studio Repository, Ultimus BPM Database, and Ultimus Business Organization 
Database hardware requirements and Table 10, Ultimus BPM Studio Repository, Ultimus BPM 
Database, Ultimus Business Organization Database, and Ultimus BPM Studio Server 
software requirements.

Ultimus BPM Studio

Ultimus BPM Studio is the design environment used to create automated business processes. 
Ultimus BPM Studio includes a client application (installed locally for each person that participates 
in business process design), and a server that manages security and collaboration for all of the 
individuals involved in design. The components of Ultimus BPM Studio are listed below.

Ultimus BPM Studio Client

Ultimus BPM Studio Client should be installed on all computers used by process developers. 
Additionally, it may also be installed on the computer hosting Ultimus BPM Server so that 
processes may be edited while working on the hosting computer.

For minimum computer requirements for Ultimus BPM Studio Client, refer to Table 5, Ultimus 
clients, Ultimus System Administrator, Ultimus Process Administrator, Ultimus BPM Studio 
Configuration, Ultimus Reports, Ultimus Director, and Ultimus Organization Charts hardware 
requirements and Table 12, Ultimus BPM Studio Client software requirements.

Ultimus BPM Studio Server

Ultimus BPM Studio Server is distinct and separate from Ultimus BPM Server. Ultimus BPM 
Studio Server manages which process repositories are created, and which users have access to 
those process repositories. Many Ultimus BPM Studio Client users can connect to a single 
repository at once and can check processes and objects in and out of the repository in a 
collaborative manner. Ultimus BPM Studio Server may reside on the same computer hosting 
Ultimus BPM Server or may be installed on separate computers.

For minimum computer requirements for Ultimus BPM Studio Server, refer to Table 3, Ultimus 
BPM Studio Client and Ultimus BPM Studio Server hardware requirements and Table 10, 
Ultimus BPM Studio Repository, Ultimus BPM Database, Ultimus Business Organization 
Database, and Ultimus BPM Studio Server software requirements.

http://www.ultimus.com/
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Ultimus BPM Studio Repository

Ultimus BPM Studio Repository is not an installed Ultimus module. It must be set up and configured 
using a supported database (detailed information about configuring supported databases is offered 
in the Preparing to install Ultimus Adaptive BPM Suite 8.3 section). Ultimus BPM Studio 
Repository functions in conjunction with Ultimus BPM Studio to maintain data pertaining to 
business process design.

In a small implementation, Ultimus BPM Studio Repository can be installed on the same computer 
as Ultimus BPM Studio. However, regardless of the implementation size, it is recommended that a 
dedicated database be used.

For minimum computer requirements to Ultimus BPM Database, refer to Table 4, Ultimus BPM 
Studio Repository, Ultimus BPM Database, and Ultimus Business Organization Database hardware 
requirements and Table 10, Ultimus BPM Studio Repository, Ultimus BPM Database, Ultimus 
Business Organization Database, and Ultimus BPM Studio Server software requirements.

Ultimus Director

Ultimus Director is used to create and manage the business rules associated with an automated 
process within a graphical user interface. Ultimus Director allows you to define rules proactively: 
before the process is used to handle active incidents.

For minimum computer requirements for Ultimus Director, refer to Table 5, Ultimus clients, 
Ultimus System Administrator, Ultimus Process Administrator, Ultimus BPM Studio Configuration, 
Ultimus Reports, Ultimus Director, and Ultimus Organization Charts hardware requirements and 
Table 11, Ultimus Director software requirements.

Ultimus FloStation

Ultimus FloStation needs to be installed on all computers designated to run Ultimus Flobots. 
Ultimus Flobots provide a powerful means of using third-party applications to perform specific 
tasks as steps in a workflow process. (For more information on Ultimus Flobots, refer to Flobots 
(“Automated Activities” in BPMN-compliant view) section in Ultimus BPM Studio Help.)

Ultimus FloStation may be installed on the computer hosting Ultimus BPM Server. However, if you 
think that many Flobots will be utilized in your business processes and/or certain Flobots will be 
used repeatedly, Ultimus recommends dedicating more than one computer for the operation of 
Ultimus FloStation.

For greater Ultimus FloStation scalability, you may want to implement a group of Ultimus 
FloStation servers. For more information on Ultimus FloStation Groups, refer to Differences 
between an Ultimus FloStation and an Ultimus FloStation Group section in Ultimus System 
Administrator Help and Ultimus Adaptive BPM Suite Configuration Guide.

For minimum computer requirements for Ultimus FloStation, refer to Table 6, Ultimus FloStation 
hardware requirements and Table 17, Ultimus FloStation software requirements.

http://www.ultimus.com/
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Ultimus Reports

Ultimus Reports is a comprehensive, Web-based report generation module that allows the design, 
generation, and access of reports securely from virtually anywhere over the Internet. Ultimus 
Reports allows the creation of powerful reports to analyze the effectiveness of processes, steps, 
users, departments, queues, and more. Results can be displayed in tabular format or in one of many 
different types of graphical formats including bar and pie charts.

For minimum computer requirements for Ultimus Reports, refer to Table 5, Ultimus clients, Ultimus 
System Administrator, Ultimus Process Administrator, Ultimus BPM Studio Configuration, Ultimus 
Reports, Ultimus Director, and Ultimus Organization Charts hardware requirements and Table 18, 
Ultimus Client and Ultimus Reports software requirements.

Ultimus Process Designer

Ultimus Process Designer is a business process modeling tool for business owners, analysts and 
process managers that provides modeling capabilities identical to those provided in Ultimus BPM 
Studio, but as a lightweight alternative. Ultimus Process Designer is available both as a stand-alone 
application and as an integrated part of Ultimus BPM Studio.

Ultimus Process Designer allows you to graphically design a business process and perform the 
activities that are essential for the successful modeling, analysis, and automation of business 
processes. Processes designed here are saved in the Ultimus WFL file format and, as such, are fully 
compatible with Ultimus BPM Studio. Ultimus Process Designer is available as a separate 
download and is ideal for those who want to design the basic flow of a process, then pass the process 
file to a process developer for full automation.

Ultimus Process Designer does not install with the Ultimus Adaptive BPM Suite, and is not covered 
in this document. Refer to the documentation which is bundled with the downloadable Ultimus 
Process Designer. Visit the Ultimus Web site at http://www.ultimus.com/ for more 
information.

Network load balancing

To better support large, high-stress implementations, Ultimus provides an optional installation process 
to support a network load balancing (NLB) environment. Running Ultimus BPM Server in an NLB 
environment is not a requirement for a basic installation.

In an NLB configuration, multiple connected servers constitute Ultimus BPM Server and provide 
scalability, redundancy, and dynamic load distribution. Ultimus supports network load balancing and 
fail-over redundancy through Ultimus BPM Server.

Before starting the installation procedure, it is beneficial to now consider your planned production 
environment needs. If you choose to configure Ultimus BPM Server in an NLB environment, it is be 
necessary to secure multiple servers.

http://www.ultimus.com/
http://www.ultimus.com/
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Network load balancing distributes the load of incoming HTTP requests to a cluster of Web servers. 
This benefits large Ultimus BPM environments with many users and Web-served forms. The Web server 
cluster also provides the first layer of fail-over redundancy by compensating for a single Web server 
outage through dynamic redistribution of connections to alternate Web servers if necessary.

The illustration below (Figure 1) graphically depicts a basic architectural structure for an NLB 
environment.

Figure 1.  A basic architectural structure for an NLB environment

Below are the prerequisites for an NLB environment:

• A Windows Server 2003 SP1, Windows Server 2008 SP2, or Windows Server 2008 R2 SP1 
operating system installed on the computer hosting Ultimus BPM Server

• Identical Web servers

• SQL Server 2008 (64-bit) or Oracle 11g

• Internet Information Server

Database
Server

Client
Workstation

Client
Workstation

Server 1 Server 2

Network Load Balancing
(Third-Party Hardware/Software)

Client
Workstation

Client
Workstation

Server 3

Assumptions of this model:

1.) Knowledge of network load balancing
configuration and setup prior to installing
the Ultimus Adaptive BPM Suite.

2.) Requests by Ultimus clients are
dynamically distributed to the next
available Ultimus BPM Server with
third-party hardware/software.

3.) Ultimus BPM Server is installed on
each server.
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1
Preparing to install Ultimus Adaptive BPM Suite 8.3

This section outlines computer hardware and software prerequisites supported for Ultimus Adaptive 
BPM Suite 8.3 (SP2) and describes the installation and configuration prerequisites.

Note: If you are installing Ultimus Adaptive BPM Suite 8.3 SP2, refer to Installing Ultimus 
Adaptive BPM Suite 8.3 SP2 section. Ultimus Adaptive BPM Suite 8.3 SP2 can only 
be installed from Ultimus Adaptive BPM Suite 8.3 or Ultimus Adaptive BPM Suite 
8.3 SP1. Ultimus recommends only installing Ultimus Adaptive BPM Suite 8.3 SP2 
when there are no critical or serious problems in the existing Ultimus Adaptive BPM 
Suite 8.3 (SP1) environment.

This section assumes you are installing Ultimus Adaptive BPM Suite 8.3. For a successful installation, 
the following steps must be performed in this order prior to installation:

1. Identifying the computer which is to host Ultimus BPM Server

2. Verifying computer hardware and software requirements

3. Required operating system components/roles to be installed

• Required Windows Server 2008 (R2) roles and role services

• Required Windows Server 2003 components

4. Identifying the Ultimus Windows account

5. Installing Internet Explorer 7.0 or later

6. Creating the Ultimus databases

7. Ensuring you have received a current version of your Ultimus License Configuration files

If using Oracle Server as Ultimus BPM Database or Ultimus Business Organization Database, the 
following steps are also necessary:

8. Install the appropriate Oracle Client on the computer hosting Ultimus BPM Server:

• Oracle 10g: Install Oracle Client 10.2.0.4.

• Oracle 11g: Install Oracle Client 11.2.0.1.0.

9. Install the appropriate Oracle Client on all computers hosting Ultimus BPM Studio Client:

• Oracle 10g: Install Oracle Client 10.2.0.4.

• Oracle 11g: Install Oracle Client 11.2.0.1.0.

http://www.ultimus.com/
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Identifying the computer which is to host Ultimus BPM Server

10. Install the appropriate Oracle Client on all computers hosting Ultimus BPM Studio Server:

• Oracle 10g: Install Oracle Client 10.2.0.4.

• Oracle 11g: Install Oracle Client 11.2.0.1.0.

11. Install the appropriate Oracle Client on all computers hosting Ultimus FloStation:

• Oracle 10g: Install Oracle Client 10.2.0.4.

• Oracle 11g: Install Oracle Client 11.2.0.1.0.

Identifying the computer which is to host Ultimus BPM Server

Ultimus BPM Server is the central component to Ultimus Adaptive BPM Suite. Ultimately, a computer 
must be identified to host Ultimus BPM Server. This computer must meet the following attributes:

• The computer hosting Ultimus BPM Server must be part of the organization’s domain.

• Ensure the computer in which Ultimus BPM Server is to be installed is not a Windows domain 
controller. On a computer serving as a Windows domain controller, it is not possible to apply the 
necessary permissions to the Ultimus account.

• The computer must meet hardware and software requirements, as specified in Verifying computer 
hardware and software requirements section.

Note: When planning to install Ultimus Adaptive BPM Suite on the computer which is to 
host Ultimus BPM Server, consider whether Microsoft Office SharePoint Server 
2007, Microsoft Office SharePoint Server 2010, Microsoft Windows SharePoint 
Services 3.0, or Microsoft SharePoint Foundation 2010 (collectively referred to as 
“Microsoft SharePoint”) is also to be installed on that computer. Note that installing 
Ultimus BPM Server and Microsoft SharePoint on the same computer is only 
supported on native 32-bit server-class operating systems; refer to the Caution 
statement below.

Microsoft SharePoint is important to the Ultimus BPM environment because it is used 
to store Ultimus Form attachments in a SharePoint Document Library. If Ultimus 
BPM Server and any version of Microsoft SharePoint are on the same computer, it is 
prudent to install Ultimus Adaptive BPM Suite first, then install Microsoft 
SharePoint. Otherwise, Microsoft SharePoint will not function properly.

If Ultimus Adaptive BPM Suite is installed after Microsoft SharePoint, Microsoft 
SharePoint must be repaired. To do so, select Start»Administrative 
Tools»Sharepoint Products and Technologies Configuration Wizard.
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Caution: Ultimus BPM Server cannot be installed on the same computer with Microsoft 
SharePoint on any 64-bit server-class operating system. This configuration is not 
supported. This is because Ultimus BPM Server and IIS are operating in 32-bit mode, 
while Microsoft SharePoint would be functioning, like the operating system, in 64-bit 
mode. Therefore, if Ultimus Adaptive BPM Suite 8.3 SP1 is being installed on any 
64-bit server-class operating system, Microsoft SharePoint must run on a separate 
computer.

Verifying computer hardware and software requirements

Before beginning the installation procedure, it is necessary to verify the computer hardware and 
software requirements for Ultimus Adaptive BPM Suite 8.3 SP2. Each Ultimus module has its own set 
of hardware and software requirements:

• Computer hardware requirements

• Computer software requirements

Computer hardware requirements

The following tables describe the minimum computer hardware requirements for operating Ultimus 
Adaptive BPM Suite 8.3 SP2. The hardware required for actual implementations of the Ultimus 
Adaptive BPM Suite vary, based on the volume of tasks to be processed, the size of forms and XML 
schemas that Ultimus BPM Server must process, among other variables.

Should you choose to implement more than one of the following servers on a single computer, the 
requirements for hard disk space are not cumulative.

For a full evaluation of a specific environment and hardware recommendations based on the level 
of projected usage, please contact your account manager or local sales representative.

The following table outlines the general computer hardware requirements for the Ultimus Adaptive 
BPM Suite.

Note: While all Ultimus modules are tested on screen resolutions between 1024x768 
and 1600x1200, higher resolutions are supported, but not tested. In contrast, 
Ultimus modules running on resolutions lower than 1024x768 are unsupported.

Table 1.  General hardware requirements for the Ultimus Adaptive BPM Suite

Hardware Requirements

CD-ROM drive 24X speed

Display Minimum: SVGA 1024x768
Maximum: SVGA 1600x1200
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Verifying computer hardware and software requirements
Computer hardware requirements

The following table outlines the computer hardware requirements for Ultimus BPM Server.

The following table outlines the computer hardware requirements for Ultimus BPM Studio Client 
and Ultimus BPM Studio Server.

The following table outlines the computer hardware requirements for Ultimus BPM Studio 
Repository, Ultimus BPM Database, and Ultimus Business Organization Database.

Table 2.  Ultimus BPM Server hardware requirements

Hardware Requirements

CPU processor Intel Pentium III or IV, 1.4 GHz or faster

RAM 4 GB or more

Hard drive space required post-installation 100 GB

Table 3.  Ultimus BPM Studio Client and Ultimus BPM Studio Server hardware requirements

Hardware Requirements

CPU processor Intel Pentium III or IV, 1.4 GHz or faster

RAM 3 GB or more

Hard drive space required post-installation 50 GB

Table 4.  Ultimus BPM Studio Repository, Ultimus BPM Database, and
Ultimus Business Organization Database hardware requirements

Hardware Requirements

CPU processor Intel Pentium III or IV, 1.4 GHz or faster

RAM 4 GB or more

Hard drive space required post-installation 200 GB
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The following table outlines the computer hardware requirements for Ultimus System 
Administrator, Ultimus Process Administrator, Ultimus BPM Studio Configuration, Ultimus 
Director, Ultimus Reports, Ultimus Organization Charts, and Ultimus clients.

The following table outlines the computer hardware requirements for Ultimus FloStation.

The following table outlines the computer hardware requirements for Ultimus Process Designer.

Table 5.  Ultimus clients, Ultimus System Administrator,
Ultimus Process Administrator, Ultimus BPM Studio Configuration, Ultimus Reports, Ultimus 

Director, and Ultimus Organization Charts hardware requirements

Hardware Requirements

CPU processor Intel Pentium III or IV, 1.4 GHz or faster

RAM 1 GB or more

Hard drive space required post-installation 20 GB

Table 6.  Ultimus FloStation hardware requirements

Hardware Requirements

CPU processor Intel Pentium III or IV, 1.4 GHz or faster

RAM 2 GB or more

Hard drive space required post-installation 50 GB

Table 7.  Ultimus Process Designer hardware requirements

Hardware Requirements

CPU processor Intel Pentium III or IV, 1.4 GHz or faster

RAM 1 GB or more

Hard drive space required post-installation 20 GB
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Verifying computer hardware and software requirements
Computer software requirements

Computer software requirements

The following tables describe the computer software requirements for operating Ultimus Adaptive 
BPM Suite 8.3 SP2. Ultimus has tested Ultimus Adaptive BPM Suite 8.3 SP2 for use with the 
software applications outlined in the following tables. The Application and Version Number 
column shows the earliest version of third-party software that Ultimus supports for use with Ultimus 
Adaptive BPM Suite 8.3 SP2. However, for optimal performance, you should always use the 
software version list in the Recommended Version column.

Tip: For all procedural instructions described in this document (such as Start Menu 
paths, directory structures, dialog box options, and figures), only the 
recommended software application is shown. For information on other versions 
of supported third-party software, consult that manufacturer’s documentation or 
support.

The following table outlines the computer software requirements for Ultimus BPM Server. Ultimus 
BPM Server requires each software component outlined below (which may not be included in a new 
installation of the operating system).

Table 8.  Ultimus BPM Server software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows Server 2003 SP2 (32-bit)

2. Windows Server 2003 R2 SP2 (32-bit)

3. Windows Server 2008 SP2 (32-bit and 
64-bit)

4. Windows Server 2008 R2 SP1

Windows Server 2008 R2 SP11

MDAC 1. MDAC 2.7

2. MDAC 2.8

Windows installs the appropriate version 
for its operating system

Web browser 1. Internet Explorer 7.0

2. Internet Explorer 8.0

3. Internet Explorer 9.0

Internet Explorer 9.0

Web server 1. Internet Information Server 6.0 
(Windows Server 2003 SP2, 32-bit)

2. Internet Information Server 7.0 
(Windows Server 2008, 32-bit)

3. Internet Information Server 7.5 
(Windows Server 2008 R2)

Internet Information Server 7.5 (Windows 

Server 2008 R2)2
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The following table outlines optional computer software which may be installed on the computer 
hosting Ultimus BPM Server.

.NET Framework .NET Framework 3.5 SP1 .NET Framework 3.5 SP1

E-mail protocols 
supported

1. MAPI

2. SMTP

n/a

1. Ultimus supports the Standard, Enterprise, and Datacenter editions of Microsoft Windows Server 2003 
and Microsoft Windows Server 2008 (R2), 32-bit and 64-bit versions.

2. When using Internet Information Server 7.0 or higher, all associated role services must be installed 
(including IIS 6 Management Compatibility).

Table 9.  Associated software used in conjunction with Ultimus BPM Server

Software Component
Application and
Version Number Recommended Version

E-mail 1. Microsoft Exchange 2003 SP2

2. Microsoft Exchange 2010 SP2

Microsoft Exchange 2010 SP2

SharePoint 1. Microsoft Office SharePoint Server 
2007

2. Microsoft Office SharePoint Server 
2010

3. Microsoft SharePoint Services 3.0

4. Microsoft SharePoint Foundation 
2010

Microsoft SharePoint Foundation 2010

LDAP 1. Sun iPlanet Directory Server 5.2

2. Netscape Directory Server 6.2

3. Novell eDirectory 8.7

4. OpenLDAP

n/a

Windows Directory 

service1
Active Directory Functional 
Level 2/Schema Level 30

Active Directory Functional 
Level 2/Schema Level 30

Table 8.  Ultimus BPM Server software requirements (Continued)

Software Component
Application and
Version Number Recommended Version
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Terminal emulation2 1. Windows 2003 Terminal Services

2. Windows 2008 Terminal Services

3. Windows 2008 R2 Remote Desktop 
Services

4. Citrix Presentation Server 3.0

Windows 2008 R2 Remote Desktop 
Services

Proxy server3 Microsoft ISA Server 2006 Standard 
Edition

Microsoft ISA Server 2006 Standard 
Edition

1. The domain controller must have at least Active Directory Domain Functional Level 2/Schema Level 
30, available since Windows Server 2003. Forest Functional Level can be 0.

2. Only Ultimus Client works with these applications for emulation. Other Ultimus modules are not 
available through emulation.

3. Ultimus has unit tested and supports the use of Microsoft Internet Security and Acceleration Server 
(MS ISA) with Ultimus Adaptive BPM Suite 8.3 SP2. Ultimus tests show that, when configured 
properly, the MS ISA server allows Ultimus Forms to properly display.

Ultimus does not broadly support the RFC standard 2616, which details HTTP transmissions and 
proxy servers. Ultimus has determined that various proxy servers that comply with the same standard 
do not function identically.

Ultimus tests show that Ultimus Adaptive BPM Suite 8.3 SP2 operates properly when Microsoft ISA 
Server 2006 Standard Edition is used running default settings while operating in integrated mode. 
When using any proxy server with Ultimus Adaptive BPM Suite, it must be set to not cache Web pages 
generated or served by Ultimus BPM Server.

Table 9.  Associated software used in conjunction with Ultimus BPM Server (Continued)

Software Component
Application and
Version Number Recommended Version
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The following table outlines the computer software requirements for Ultimus BPM Studio 
Repository, Ultimus BPM Database, Ultimus Business Organization Database, and Ultimus BPM 
Studio Server.

Table 10.  Ultimus BPM Studio Repository, Ultimus BPM Database, Ultimus Business 
Organization Database, and Ultimus BPM Studio Server software requirements

Database Type
Application and
Version Number Recommended Version

SQL Server database 1. SQL Server 2005 SP4 (32-bit)1

2. SQL Server 2008 (32-bit and 64-bit)

3. SQL Server 2008 R2 (32-bit and 
64-bit)

1. Ultimus BPM Studio Repository, Ultimus BPM Database, and Ultimus Business Organization 
Database are supported on both the Standard and Enterprise Editions of SQL Server 2005.

SQL Server 2008 R2 (64-bit)

SQL Server database 
drivers

Microsoft drivers for SQL Server Microsoft drivers for SQL Server

Oracle database2

2. Ultimus BPM Studio Repository, Ultimus BPM Database, and Ultimus Business Organization 
Database support the Oracle database releases on Windows and Unix platforms. However, Ultimus 
specifically tests Oracle database and Oracle patch releases available on Windows platforms. 
Functionality differences between Oracle on Windows and Unix platforms may be seen within the 
Ultimus Adaptive BPM Suite. Ultimus makes every effort to support those differences within the 
Ultimus Adaptive BPM Suite if and when issues are reported to Ultimus Support.

1. Oracle Database 10g Release 1 
(10.1.0.4)3

2. Oracle Database 10g Release 2 
(10.2.0.4)4

3. Oracle Database 11g Release 2 
(11.2.0.1.0)5

4. Oracle XE6

3. If Oracle 10g Release 1 is installed, ensure the “Oracle 10g ODAC 10.1.0.4.0” patch from 
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html is 
installed.

4. If Oracle 10g Release 2 is installed, ensure the “Oracle Developer Tools for Visual Studio .NET with 
Oracle 10g Release 2 ODAC 10.2.0.2.21” patch from 
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html is 
installed.

Oracle Database 11g Release 2 
(11.2.0.1.0)

Oracle client 1. Oracle 10g

2. Oracle 11g

Oracle 11g

IBM DB2 IBM DB2 version 9.5 IBM DB2 version 9.5

http://www.oracle.com/technology/software/tech/windows/odpnet/index.html
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html
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The following table outlines the computer software requirements for Ultimus Director.

5. If Oracle 11g Release 2 is installed, ensure the “Oracle 11g ODAC 11.2.0.2.1” patch from 
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html is 
installed.

6. Oracle XE Edition can be utilized as Ultimus BPM Database in development and/or test BPM 
environments. Oracle XE Edition is not supported as Ultimus BPM Database for production 
environments. Please note that Ultimus Adaptive BPM Suite is not specifically tested against Oracle 
XE Edition and code changes for Ultimus Adaptive BPM Suite are not provided if issues are 
experienced while using this version of Oracle database.

Table 11.  Ultimus Director software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows 7 SP1

Web browser 1. Internet Explorer 7.0

2. Internet Explorer 8.0

3. Internet Explorer 9.0

Internet Explorer 9.0

http://www.ultimus.com/
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The following table outlines the computer software requirements for Ultimus BPM Studio Client.

Table 12.  Ultimus BPM Studio Client software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows 7 SP1

.NET Framework1

1. Microsoft .NET Framework 3.5 SP1 is required on the computer running Ultimus BPM Studio to 
develop Word and Excel Forms.

.NET Framework 3.5 SP1 .NET Framework 3.5 SP1

Web browser 1. Internet Explorer 7.0

2. Internet Explorer 8.0

3. Internet Explorer 9.0

Internet Explorer 9.0

Office application2 1. Microsoft Office 2007 SP2

2. Microsoft Office 2010

Microsoft Office 2007 SP2

Recordset database 1. SQL Server 2005 SP4 (32-bit)3

2. SQL Server 2008 (32-bit and 64-bit)

3. SQL Server 2008 R2 (32-bit and 
64-bit)

4. Oracle Database 10g Release 1 
(10.1.0.4)4

5. Oracle Database 10g Release 2 
(10.2.0.4)5

6. Oracle Database 11g Release 2 
(11.2.0.1.0)6

7. Oracle XE7

1. SQL Server 2008 R2 (64-bit)

2. Oracle Database 11g Release 2 
(11.2.0.1.0)
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2. Word 2007 software distributed by Microsoft after January 10, 2010 (and Word 2010), no longer read 
the custom XML markup that may be contained within .DOCX, .DOCM, .DOTX, .DOTM, or .XML 
files. Word 2010, new versions of Word 2007, and the updated version of Word 2003 can still open 
these files, but any custom XML markup is removed. If you apply this update to versions Word 2007 
that were distributed by Microsoft before January 11, 2010, the updated version will treat custom XML 
markup in the same manner as versions of Word distributed by Microsoft after January 10, 2010. 
This causes Word Flobots, Smart Attachments, and Process Documentation to fail.

Ultimus Adaptive BPM Suite 8.3 introduced support for Word 2007 SP3 and Word 2010 for Word 
Flobots to train Word documents without the need of an external XML Schema (XSD). The classic 
Word Flobots (with external XSD), Smart Attachments, and Process Documentation do not work with 
Word 2007 SP3 and Word 2010.

3. Ultimus BPM Studio Repository, Ultimus BPM Database, and Ultimus Business Organization 
Database are supported on both the Standard and Enterprise Editions of SQL Server 2005.

4. If Oracle 10g Release 1 is installed, also ensure the “Oracle 10g ODAC 10.1.0.4.0” patch from 
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html is 
also installed.

5. If Oracle 10g Release 2 is installed, also ensure the “Oracle Developer Tools for Visual Studio .NET 
with Oracle 10g Release 2 ODAC 10.2.0.2.21” patch from 
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html is 
also installed.

6. If Oracle 11g Release 2 is installed, ensure the “Oracle 11g ODAC 11.2.0.2.1” patch from 
http://www.oracle.com/technology/software/tech/windows/odpnet/index.html is 
installed.

7. Oracle XE Edition can be utilized as Ultimus BPM Database in development and/or test BPM 
environments. Oracle XE Edition is not supported as Ultimus BPM Database for production 
environments. Please note that Ultimus Adaptive BPM Suite is not specifically tested against Oracle 
XE Edition and code changes for Ultimus Adaptive BPM Suite are not provided if issues are 
experienced while using this version of Oracle database.

http://www.ultimus.com/
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The following table outlines the computer software requirements for Ultimus BPM Studio 
Configuration.

The following table outlines the computer software requirements for Ultimus System Administrator.

Table 13.  Ultimus BPM Studio Configuration software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows Server 2008 R2 SP1

LDAP 1. Sun iPlanet Directory Server 5.2

2. Netscape Directory Server 6.2

3. Novell eDirectory 8.7

4. OpenLDAP

n/a

MMC MMC 3.0 MMC 3.0

Table 14.  Ultimus System Administrator software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows Server 2008 R2 SP1

MMC MMC 3.0 MMC 3.0
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The following table outlines the computer software requirements for Ultimus Process 
Administrator.

The following table outlines the computer software requirements for Ultimus Organization Charts.

Table 15.  Ultimus Process Administrator software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows Server 2008 R2 SP1

Table 16.  Ultimus Organization Charts software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows 7 SP1

Web browser 1. Internet Explorer 7.0

2. Internet Explorer 8.0

3. Internet Explorer 9.0

Internet Explorer 9.0
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The following table outlines the computer software requirements for Ultimus FloStation.

Table 17.  Ultimus FloStation software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows Server 2008 R2 SP1

.NET Framework .NET Framework 3.5 SP1 .NET Framework 3.5 SP1

Office application1 2

1. While Microsoft Office is specifically required on computers hosting Ultimus FloStations, Word and 
Excel documents generated by Word Flobots and Excel Flobots can be configured to be compatible 
with Microsoft Office 2003 systems. This allows all Ultimus Forms users to view those generated 
Flobot documents using the older Microsoft Office 2003 applications. Information on how to 
configure Word Flobots and Excel Flobots to generate documents compatible with Microsoft Office 
2003 applications can be found in the Ultimus Adaptive BPM Suite Configuration Guide.

1. Microsoft Office 2007

2. Microsoft Office 2010

Microsoft Office 2010

Web browser 1. Internet Explorer 7.0

2. Internet Explorer 8.0

3. Internet Explorer 9.0

Internet Explorer 9.0

SharePoint3 4 1. Microsoft Office SharePoint Server 
2007

2. Microsoft Office SharePoint Server 
2010

3. Microsoft SharePoint Services 3.0

4. Microsoft SharePoint Foundation 
2010

Microsoft SharePoint Foundation 2010

E-mail Microsoft Exchange 2003 SP2 Microsoft Exchange 2003 SP2

E-mail protocols 
supported

1. MAPI

2. SMTP

n/a

MMC5 MMC 3.0 MMC 3.0
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The following table outlines the computer software requirements for Ultimus Client and Ultimus 
Reports.

2. Word 2007 software distributed by Microsoft after January 10, 2010 (and Word 2010), no longer read 
the custom XML markup that may be contained within .DOCX, .DOCM, .DOTX, .DOTM, or .XML 
files. Word 2010, new versions of Word 2007, and the updated version of Word 2003 can still open 
these files, but any custom XML markup is removed. If you apply this update to versions Word 2007 
that were distributed by Microsoft before January 11, 2010, the updated version will treat custom XML 
markup in the same manner as versions of Word distributed by Microsoft after January 10, 2010. 
This causes Word Flobots, Smart Attachments, and Process Documentation to fail.

Ultimus Adaptive BPM Suite 8.3 introduced support for Word 2007 SP3 and Word 2010 for Word 
Flobots to train Word documents without the need of an external XML Schema (XSD). The classic 
Word Flobots (with external XSD), Word Forms, Smart Attachments, and Process Documentation do 
not work with Word 2007 SP3 and Word 2010.

3. The SharePoint Flobot requires Microsoft SharePoint to function.

4. Ultimus BPM Server cannot be installed on the same computer with Microsoft SharePoint on any 
64-bit server-class operating system. This configuration is not supported. This is because Ultimus 
BPM Server and IIS are operating in 32-bit mode, while Microsoft SharePoint would be functioning, 
like the operating system, in 64-bit mode. Therefore, if Ultimus Adaptive BPM Suite 8.3 SP2 is being 
installed on any 64-bit server-class operating system, Microsoft SharePoint must run on a separate 
computer.

5. Computers which host Ultimus FloStation Configuration (used to configure Ultimus FloStation 
installations) must have MMC 3.0 installed.

Table 18.  Ultimus Client and Ultimus Reports software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows 7 SP1

.NET Framework .NET Framework 3.5 SP11 .NET Framework 3.5 SP1
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The following table outlines the computer software requirements for Ultimus Thin Client.

Web browser 1. Internet Explorer 7.0

2. Internet Explorer 8.0

3. Internet Explorer 9.0

Internet Explorer 9.0

E-mail 1. Microsoft Office Outlook 2007

2. Microsoft Office Outlook 2010

Microsoft Office Outlook 2010

1. The English-language version of Microsoft .NET Framework 3.5 SP1 may be downloaded from 
http://www.microsoft.com/en-us/download/details.aspx?id=22.

Table 19.  Ultimus Thin Client software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows 7 SP1

Web browser thin client1

1. Ultimus Thin Client has been tested only on the operating systems and Web browsers listed in the table 
above. Ultimus Thin Client may operate on, but has not been specifically tested against, other 
operating systems and Web browsers. Ultimus only supports Ultimus Thin Client issues on operating 
systems and Web browsers listed in the table above that are still under mainstream support by their 
respective vendors.

1. Internet Explorer 6.02

2. Internet Explorer 7.0

3. Internet Explorer 8.0

4. Internet Explorer 9.0

2. Internet Explorer 6 is supported only with Ultimus Thin Client and ASP.NET forms. 
Internet Explorer 7 or later is required when using Ultimus Client and Ultimus Forms.

Internet Explorer 9.0

Table 18.  Ultimus Client and Ultimus Reports software requirements (Continued)

Software Component
Application and
Version Number Recommended Version

http://www.ultimus.com/
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The following table outlines the computer software requirements for Ultimus Process Designer.

Table 20.  Ultimus Process Designer software requirements

Software Component
Application and
Version Number Recommended Version

Operating system 1. Windows XP Professional SP3

2. Windows Vista SP3

3. Windows 7 SP1

4. Windows Server 2003 SP2 (32-bit)

5. Windows Server 2008 SP2 (32-bit and 
64-bit)

6. Windows Server 2008 R2 SP1

Windows 7 SP1

Web browser 1. Internet Explorer 7.0

2. Internet Explorer 8.0

3. Internet Explorer 9.0

Internet Explorer 9.0
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Server sizing considerations

Ultimus provides the following information to assist you in selecting hardware for Ultimus BPM 
Server, Ultimus BPM Database, and Ultimus FloStation installations appropriate to your level of 
business process activity.

The following table provides server sizing suggestions taking into account existing Ultimus 
Adaptive BPM Suite installations of the varying sizes.

Projecting larger implementations

Ultimus can scale to manage BPM for any size enterprise. The examples above can be multiplied 
through load balancing and hardware expansion.

When scaling Ultimus for large-scale use, consider the following:

• Increasing RAM on both the computers hosting Ultimus BPM Server and Ultimus BPM 
Database generally makes each more responsive.

• Due to parallel reading and writing, efficiency of the database server can be best improved 
by adding multiple hard drives rather than a single, larger drive.

• If using a 100 Mbs Ethernet, at some level of BPM activity, your network bandwidth also 
becomes a limitation. When traffic passes 60% of bandwidth, upgrading to a gigabit network 
should result in improved performance.

Ultimus Professional Services and your network administrator may have additional 
recommendations for improving BPM performance.

Table 21.  Server sizing examples

Size

Number of 
Transactions 

per Day

Ultimus BPM 
Server 

Specifications

Ultimus BPM 
Database 

Specifications
Ultimus FloStation 

Specifications

Small 900 1. Single P4 2.0 GHz 
processor

2. 4 GB RAM

3. 40 GB hard drive

1. Single P4 2.0 GHz 
processor

2. 4 GB RAM

3. 96 GB hard drive

1. Single P4 2.0 GHz 
processor

2. 1 GB RAM

3. 40 GB hard drive

Medium 8,400 1. Dual P4 2.4 GHz 
processors

2. 4 GB RAM

3. 80 GB hard drive

1. Dual P4 2.4 GHz 
processors

2. 4 GB RAM

3. 160 GB hard drive

1. Single P4 2.4 GHz 
processor

2. 1 GB RAM

3. 50 GB hard drive

Large 20,000 or more 1. Quad P4 3 GHz 
processors

2. 4 GB RAM

3. 120 GB hard drive

1. Quad P4 3 GHz 
processors

2. 4 GB RAM

3. 160 GB hard drive

1. Dual P4 3 GHz 
processors

2. 1 GB RAM

3. 50 GB hard drive
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Required operating system components/roles to be installed

Depending on the operating system will be used to host Ultimus BPM Server, specific Windows Server 
2003 components (or specific Windows Server 2008 (R2) roles and related role services) must be 
installed prior to installing Ultimus Adaptive BPM Suite. These roles are outlined based on Windows 
server-class operating system:

• Required Windows Server 2008 (R2) roles and role services

• Required Windows Server 2003 components

As part of the Ultimus BPM Server installation, the installer creates UltWeb, UltDocs, and 
PLWebServices directories in IIS in the path \inetpub\wwwroot. The Ultimus installation 
determines where this IIS folder is located, as configured in the Local Path: field of the Default Web 
Site Properties on the Home Directory tab. Note that if you wish to move IIS from its default location 
to another file location, this change must take place before Ultimus Adaptive BPM Suite is installed.

Required Windows Server 2008 (R2) roles and role services

The following roles and respective role services must be installed prior to installing Ultimus 
Adaptive BPM Suite:

• Application Server

• File Services

• Internet Information Services (IIS) 7.0 or later

IIS installs the Application Server role. As part of the IIS role installation, ensure all role 
services associated with IIS are also installed (including “II6 Compatibility Mode”).

Furthermore, the following role services must be installed:

• .NET Framework 3.5.1

• Web Server (IIS) Support

• COM+ Network Access

• TCP Port Sharing

• Windows Process Activation Service Support

• HTTP Activation

• Message Queuing Activation

• TCP Activation

• Named Pipes Activation

• Distributed Transactions

• Incoming Remote Transactions

• Outgoing Remote Transactions

http://www.ultimus.com/
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Required Windows Server 2003 components

The following Windows components must be installed prior to installing Ultimus Adaptive BPM 
Suite:

• Internet Information Services (IIS) 6

• Component Services (COM+)

Identifying the Ultimus Windows account

Before Ultimus BPM Server or Ultimus FloStation can be installed, the Ultimus Windows account with 
the appropriate Administrator rights must be created. This account is used during the Ultimus Adaptive 
BPM Suite installation to configure the five Ultimus services and to configure the Ultimus COM+ 
components.

The following are requirements for the Ultimus Windows account:

• The Ultimus Windows account must be a domain account, not a local server account.

• The Ultimus Windows account name must not have spaces or special characters.

Once you have created the Ultimus Windows account on your domain for the computer hosting Ultimus 
BPM Server, you must ensure the account has the following rights assigned to it:

• The account must have local Administrator rights on the computer hosting Ultimus BPM Server.

• The account must be assigned the advanced right of Act as a part of the operating system.

• The account must be assigned the advanced right of Log on as a service.

• The account must be assigned the advanced right of Log on as a batch job.

Installing Internet Explorer 7.0 or later

Ultimus Adaptive BPM Suite 8.3 SP2 requires the use of Microsoft Internet Explorer 7.0 or later. If it 
is not already installed, Internet Explorer 7.0 (or later) must be installed prior to installing any 
component of the Ultimus Adaptive BPM Suite. Ultimus recommends installing Internet Explorer 9.0.
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Creating the Ultimus databases

The creation of up to three Ultimus databases is necessary to support the Ultimus BPM environment. 
Ultimus Business Organization Database can be a separate database from Ultimus BPM Database. 
By having Ultimus Business Organization Database as a separate database, the Ultimus Adaptive BPM 
Suite production and testing environments can utilize a single Ultimus Organization Charts resource. 
The following lists the different databases utilized in the Ultimus BPM environment:

• Ultimus BPM Database: Ultimus BPM Database is the data repository for Ultimus BPM 
Server.

• Ultimus BPM Studio Repository: Ultimus BPM Studio Repository is the data repository for 
Ultimus BPM Studio.

• Ultimus Business Organization Database: Ultimus Business Organization Database is the data 
repository for business organizations. This database is accessed by Ultimus BPM Server.

Creating these databases may require the assistance of a specific network or database administrator.

Note: A dedicated computer may be used to host all three databases.

These databases may be created with any names using only alphanumeric characters. It is important to 
note that when creating empty databases, they must be created in either Microsoft SQL Server or in 
Oracle; it is not necessary to create the Ultimus databases in both server environments, even if you have 
both Microsoft SQL Server and Oracle installed on the computer hosting Ultimus BPM Server.

Tip: If you are using a Microsoft SQL Server database, Ultimus Adaptive BPM Suite can 
use a single trusted connection to SQL Server. To learn more about configuring a 
trusted SQL Server connection, refer toConfiguring a trusted database connection to 
SQL Server section in Ultimus Adaptive BPM Suite Configuration Guide.

Caution: If using a remote SQL Server 2005 SP2 or SQL Server 2008 (R2) database, distributed 
transactions must be enabled. To verify this setting, follow these steps:

a. Open SQL Server Management Studio for your SQL Server application.

b. Select the remote database application instance hosting Ultimus BPM Database 
and/or Ultimus Business Organization Database, right-click, then select 
Properties.

c. From the Select a page section, click on the Connections page.

d. Select the View Server Permissions link.

e. From the Select a page section, click on the Connections page.

f. Select the Require distributed transactions for server-to-server 
communications option, then click the OK button.
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Caution: If you are using a Microsoft SQL Server database, it is imperative to verify that your 
installation is not configured with case-sensitive sort collation. If the SQL Server 
database is set to case-sensitive sort collation, then some columns within Ultimus 
BPM Studio Client are not recognized, as they are capitalized.

If your Microsoft SQL Server database does have case-sensitive sort collation 
enabled, then you must first uninstall your SQL Server database, then re-install it with 
case-sensitive sort collation disabled.

Note: If using an Oracle database application, verify the appropriate Oracle Client 
application is installed on the computers hosting the following Ultimus modules:

• Ultimus BPM Server

• Ultimus BPM Studio (Client and Server)

• Ultimus FloStation

Caution: Any given user needs CONNECT, DBA and RESOURCE privileges to connect and 
create the Ultimus BPM tables. The DBA privilege allows creating the User Queue 
view. Refer to Oracle documentation in regards to the RESOURCE privilege. This 
privilege gives the user unlimited disk resources to create objects and should be used 
with caution.

Ensuring you have received a current version of your Ultimus License 
Configuration files

Unless upgrading from Ultimus Adaptive BPM Suite 8.x, new Ultimus License Configuration files must 
be obtained from Ultimus prior to installing Ultimus Adaptive BPM Suite 8.3 SP2 (regardless of 
whether you are an existing Ultimus customer or not). If you are not sure whether you have the 
appropriate License Configuration files for Ultimus Adaptive BPM Suite 8.3 SP2, please contact your 
local administrator and/or Ultimus account manager.

You are ready to install the Ultimus Adaptive BPM Suite. Continue to Installing Ultimus Adaptive BPM 
Suite 8.3 or 8.3 SP2 section.
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Installing Ultimus Adaptive BPM Suite 8.3 or 8.3 SP2

This section outlines how to install both Ultimus Adaptive BPM Suite 8.3 and Ultimus Adaptive BPM 
Suite 8.3 SP2. Ultimus Adaptive BPM Suite 8.3 SP2 can only be installed from Ultimus Adaptive BPM 
Suite 8.3 or Ultimus Adaptive BPM Suite 8.3 SP1. Refer to one of the following sections depending on 
which Ultimus Adaptive BPM Suite version you are installing:

• Installing Ultimus Adaptive BPM Suite 8.3

• Installing Ultimus Adaptive BPM Suite 8.3 SP2

Installing Ultimus Adaptive BPM Suite 8.3

This section outlines how to install Ultimus Adaptive BPM Suite 8.3. Refer to the following sections:

• Required files for installation

• Installing Ultimus Adaptive BPM Suite 8.3

• Adding additional modules to the Ultimus Adaptive BPM Suite 8.3 installation

• Exiting the Ultimus Adaptive BPM Suite 8.3 installation program

• Adding additional modules to the Ultimus Adaptive BPM Suite 8.3 installation

• Uninstalling Ultimus Adaptive BPM Suite 8.3

Each of these sections is discussed below.

Required files for installation

The Ultimus Adaptive BPM Suite installation 8.3 files are either shipped on a DVD with the Ultimus 
License Configuration files or downloaded from the Ultimus Customer Console. All future 
upgrades may be downloaded from the Ultimus Online Support page at 
http://www.ultimussupport.com. If you are an existing customer utilizing Ultimus BPM 
Suite version 7 or earlier releases, new Ultimus License Configuration files are necessary to install 
Ultimus Adaptive BPM Suite 8.3. Please be sure to keep the original Ultimus License Configuration 
files or a copy of the Ultimus License Configuration files, as you may need these files when 
upgrading Ultimus Adaptive BPM Suite to the latest version in the future. Prior to any installation, 
always verify that you are installing the appropriate Ultimus Adaptive BPM Suite version.

http://www.ultimus.com/
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Installing Ultimus Adaptive BPM Suite 8.3

This section discusses in detail how to install Ultimus Adaptive BPM Suite 8.3.

Note: This section does not discuss how to install Ultimus Adaptive BPM Suite 8.3 SP2. 
For Ultimus Adaptive BPM Suite 8.3 SP2 installation instructions, refer to 
Installing Ultimus Adaptive BPM Suite 8.3 SP2 section. Ultimus Adaptive BPM 
Suite 8.3 SP2 can only be installed from Ultimus Adaptive BPM Suite 8.3 or 
Ultimus Adaptive BPM Suite 8.3 SP1.

Since all Ultimus modules rely on a connection to Ultimus BPM Server, the first module to be 
installed to your Ultimus environment must be Ultimus BPM Server, though you may choose to 
install other modules at the same time. For example, it is recommended to install the Ultimus System 
Administrator on the same computer hosting Ultimus BPM Server.

When installing Ultimus BPM Server to the latest release, it is required that you also install all 
Ultimus modules on remote computers to the same Ultimus release version. In other words, once the 
Ultimus BPM Server installation is completed, all remote computers hosting Ultimus BPM Studio, 
Ultimus System Administrator, and Ultimus FloStation installations must immediately be deployed 
to the new Ultimus release version.

Ultimus Adaptive BPM Suite 8.3 may be installed one of two ways:

• Upgrade from Ultimus Adaptive BPM Suite 8.x: Ultimus Adaptive BPM Suite 8.3 may 
be installed from Ultimus Adaptive BPM Suite 8.x as an upgrade. If installed this way, 
Ultimus Adaptive BPM Suite 8.3 installs in the same directory as Ultimus Adaptive BPM 
Suite versions 8.0, 8.1, or 8.2 (thereby overwriting the existing installation).

• Install into a new Ultimus BPM environment: Ultimus Adaptive BPM Suite 8.3 may be 
installed into an Ultimus BPM environment which has never had any Ultimus product 
installed. If installed this way, Ultimus Adaptive BPM Suite 8.3 by default installs into the 
directory: Windows System:\Program Files (x86)\Ultimus Adaptive 
BPM Suite 8.3 (where Windows System is the hard drive in which the Windows 
operating system is installed).

Each of these installation options is integrated into the installation procedure below.

To install Ultimus Adaptive BPM Suite 8.3, follow these steps:

1. Ensure you are logged onto the computer which is to host Ultimus BPM Server with the same 
Windows account created in the Identifying the Ultimus Windows account section.

2. Close all applications, including any applications automatically invoked during Windows 
start-up.

3. Identify the location of the Ultimus License Configuration files on the computer hosting 
Ultimus BPM Server.
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4. Do one of the following, depending on whether you are installing Ultimus Adaptive BPM 
Suite from an Ultimus CD or installation files from the Ultimus Web site:

a. Installing from an Ultimus DVD: Insert the Ultimus DVD into the DVD-ROM drive. 
The Ultimus installation program should launch automatically. If the Ultimus 
installation program does not launch automatically, then run the Setup.exe file.

b. Installing from downloaded files: Extract the installation files from the downloaded 
executable. Ensure to extract the files to a folder on the local hard drive and not to a 
folder specified by a UNC path. Once the installation files are extracted, run the 
Setup.exe file.

Tip: Instead of double-clicking on Setup.exe, right-click the executable, then select 
Run as administrator.

The installation wizard verifies that particular third-party technologies are installed on the 
computer on which Ultimus Adaptive BPM Suite is being installed. If any of these technologies 
are not installed on the computer, then the installation wizard notifies you and cannot continue:

• Internet Information Services (IIS) Manager for your operating system version. Note 
that IIS Manager 7 or higher is installed by the IIS 6 Compatibility role services are not, 
then the installation wizard notifies you that IIS Manager is not installed. To address this, 
install all IIS Manager 7 role services.

• Microsoft .NET Framework 3.5 SP1

• Microsoft Data Access Component

• MMC 3.0 (This is checked at the time when specific suite modules are selected; if a 
module is selected that requires MMC 3.0, then the installation wizard notifies you to 
only select modules which do not use MMC 3.0.)
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If Ultimus Adaptive BPM Suite 8.x is already installed, the installation wizard acknowledges 
that an upgrade is taking place (as shown in Figure 1).

Figure 1.  Upgrading from Ultimus Adaptive BPM Suite 8.x

If installing Ultimus Adaptive BPM Suite 8.3 for the first time, the installation wizard displays 
the welcome page (as shown in Figure 2).

Figure 2.  The Ultimus Adaptive BPM Suite installation wizard

5. Click the Next button. The License Agreement page appears. Verify that you understand the 
terms of the license agreement. If you accept the terms of the license, then select the I accept 
the license agreement option, then select Next. If you do not agree to the terms, select I do 
not accept the license agreement, then select Next or Cancel to abort the installation.
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After the license agreement has been agreed to, the User Information dialog box appears, as 
shown in Figure 3.

Figure 3.  The User Information page of the installation wizard

Your full name and the name of your organization, provided by your operating system, populate 
these text boxes by default. Do not change their displayed values.

6. Choose the Everyone option, then click the Next button.
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7. The Ultimus Locations page appears (as shown in Figure 4, when Ultimus Adaptive BPM 
Suite 8.3 is being installed for the first time).

Note: If Ultimus Adaptive BPM Suite 8.3 is being upgraded from versions 8.0 through 
8.2, the Browse button in the Destination Folder group is disabled.

Figure 4.  The Ultimus Locations page of the installation wizard

Use the Browse button to select the destination folder into which the Ultimus Adaptive BPM 
Suite is to be installed (if you do not wish to accept the default path).

Caution: If installing Ultimus Adaptive BPM Suite 8.x for the first time, Ultimus BPM 
Server must be installed to a local drive on the hosting computer. During 
installation, all Ultimus installation files are copied to a temporary folder which 
is always on the system drive. Therefore, there must always be sufficient free 
space on that drive to support the installation (approximately 1.4 GB). 
If sufficient space is not available on the system drive, the installation cannot 
proceed.

8. Use the Browse button to select the path for the Ultimus License Configuration files. 
The installation will not proceed until the Ultimus License Configuration files are located.

Caution: Unless upgrading from Ultimus Adaptive BPM Suite 8.x, new Ultimus License 
Configuration files must be obtained from Ultimus prior to installing Ultimus 
Adaptive BPM Suite 8.3 (regardless of whether you are an existing Ultimus 
customer or not). If you are not sure whether you have the appropriate License 
Configuration files for Ultimus Adaptive BPM Suite 8.3, please contact your 
local administrator and/or Ultimus account manager.
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9. Click the Next button. The Select Modules page of the installation wizard appears (as shown 
in Figure 5, when installing Ultimus Adaptive BPM Suite 8.3 for the first time).

Figure 5.  The Select Modules page of the installation wizard

Here, you may select individual Ultimus Adaptive BPM Suite modules to be installed. 
Follow these guidelines to specify which Ultimus modules are to be installed:

• Selecting modules for installation: To select a module for installation, click that 
module’s name, then select the Will be Installed on Local Hard Drive option.

• Deselecting modules for installation: To deselect a module for installation, click that 
module’s name, then select the Entire feature will be Unavailable option.

Modules which are already installed have a  icon next to their names. Modules which do not 
have this icon may be installed at this time.

For a description of all modules offered in Ultimus Adaptive BPM Suite, refer to Major 
components of the Ultimus Adaptive BPM Suite section.

Tip: If Ultimus BPM Server is among the modules being installed, also install Ultimus 
System Administrator (which is used to configure Ultimus BPM Server after 
Ultimus Adaptive BPM Suite has been installed).

Tip: Select the Process Migration Tool feature (listed under Ultimus BPM Studio) to 
install the migration tool which may be used to migrate business processes from 
Ultimus BPM Suites versions 6.x or 7.x to Ultimus Adaptive BPM Suite 8.3. If 
this option is selected, a short-cut from the Ultimus Adaptive BPM Suite short-cut 
group is displayed to access the migration tool. For information on how to use the 
migration tool after installation is completed, refer to Using the Process 
Migration Tool for Ultimus Adaptive BPM Suite 8.3.
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10. Once all desired modules have been selected to be installed, click the Next button. Refer to 
the conditions outlined below to determine from which step in the installation procedure to 
continue:

a. Ultimus BPM Server is among the modules selected for installation: Continue with 
the installation procedure from Step 11.

b. Ultimus BPM Server is not among the modules selected for installation, but 
Ultimus BPM Studio Server, Ultimus Director, Ultimus FloStation, and/or 
Ultimus System Administrator is: The Ultimus BPM Server Settings dialog box 
appears (as shown in Figure 6). Enter or browse to select the name of the computer 
onto which you have already installed Ultimus BPM Server, then click the OK button.

Figure 6.  The Ultimus BPM Server Settings dialog box

Continue with the installation procedure from Step 14.

11. If Ultimus BPM Server has been selected for installation and two or more Web sites exist on 
the computer in which Ultimus BPM Server is being installed (as set up in Internet 
Information Services (IIS) Manager), the Website Configuration dialog box appears 
(as shown in Figure 7). This dialog box is used to specify which Web site is to host Ultimus 
BPM Server.

Figure 7.  The Website Configuration dialog box

From the Website for server installation: combo box, specify the IIS Web site which has been 
created for Ultimus BPM Server, then click the OK button.
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Tip: If either of the following conditions are true, then the Website Configuration 
dialog box is not displayed:

• There is no more than one Web site configured on the computer in which 
Ultimus BPM Server is to be installed. If no Web site has yet to be 
configured on the computer which is to host Ultimus BPM Server and 
Ultimus BPM Server has been selected for installation, stop the 
installation procedure to create an IIS Web site. For instructions on how to 
do so, refer to Required operating system components/roles to be installed 
section.

• Ultimus BPM Server has not been selected for installation.

12. If Ultimus BPM Server has been selected for installation, the BPM Server Database 
Settings dialog box appears, as shown in Figure 8.

The BPM Server Database Settings dialog box is used to specify connection information to 
Ultimus BPM Database. This dialog box by default displays field settings if Microsoft SQL 
Server is to be used as Ultimus BPM Database (with the SQL Server option selected from the 
Database Type: combo box).

Figure 8.  SQL Server field settings in the BPM Server Database Settings dialog box
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If the Oracle option is selected from the Database Type: combo box, the field settings in the 
BPM Server Database Settings dialog box display connection settings to an Oracle database 
(as shown in Figure 9).

Figure 9.  Oracle field settings in the BPM Server Database Settings dialog box

Within the BPM Server Database Settings dialog box, enter the following information:

a. Database Type: From the Database Type: combo box, select the SQL Server or 
Oracle option, depending on which application was used to create Ultimus BPM 
Database (as outlined in the Creating the Ultimus databases section).

b. Server Name: If SQL Server is being used as Ultimus BPM Database, enter the name 
of the computer hosting Ultimus BPM Database into the Server Name: text box. If 
Oracle is being used as Ultimus BPM Database, then enter the name of the TNS entry 
associated with the configured Ultimus BPM Database 8.3 tablespace into the Service 
Name: text box.

Note: If typing the name of the computer hosting a SQL Server application, ensure 
not to use a period (.) in place of the computer name (which implies the 
default instance of SQL Server on that computer). Placing a period instead of 
the name can cause Ultimus Adaptive BPM Suite to access the SQL Server 
database slowly.

c. User ID: In the User ID: text box, enter the log on user name to access Ultimus BPM 
Database.

d. Password: In the Password: text box, enter the password required to access Ultimus 
BPM Database.
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Tip: To connect to Ultimus BPM Database using a trusted SQL connection, leave 
the User ID: and Password: text boxes blank. To learn more how to 
configure a trusted SQL connection, refer to section in Configuring a trusted 
database connection to SQL Server Ultimus Adaptive BPM Suite 
Configuration Guide.

Caution: If using the user name sa (system administrator), it is prudent to use an 
effective password for security protection. Since the system administrator of 
SQL Server has full access rights to SQL database servers, password security 
is important.

e. Catalog: In the Catalog: combo box, enter the name of the Ultimus BPM Database 
that was created (as outlined in Creating the Ultimus databases of the Preparing to 
install Ultimus Adaptive BPM Suite 8.3 section). This information is necessary only if 
SQL Server is being used as Ultimus BPM Database; it does not appear if the Oracle 
option is selected from the Database Type: combo box.

You may click the Test Connection button to test the connection to Ultimus BPM 
Database. If a connection is achieved, the message Connection was successful displays. 
If a connection is not achieved, the message Unable to connect to Database. Username 
or password invalid. displays.

Tip: If Ultimus BPM Database and Ultimus Business Organization Database are 
using the same physical database (and therefore the same connection 
settings), select the Use same settings for Business Organization option. 
The same settings specified for Ultimus BPM Database are configured to 
connect to Ultimus Business Organization Database.
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13. Click the OK button to close the BPM Server Database Settings dialog box.

Tip: If the Use same settings for Business Organization option is not selected, 
then the Business Organization Database Settings dialog box appears (as 
shown in Figure 10). The Business Organization Database Settings dialog 
box is used to specify connection information to Ultimus Organization 
Database.

Specify connection information to Ultimus Organization Database similarly 
as you specified connection information to Ultimus BPM Database.

Figure 10.  Business Organization Database Settings dialog box
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14. The Windows Account Information page appears (as shown in Figure 11). The account 
specified must be the same Windows account created in section Identifying the Ultimus 
Windows account of the Preparing to install Ultimus Adaptive BPM Suite 8.3 section. 
This dialog box only appears when installing Ultimus BPM Server or Ultimus FloStation.

Figure 11.  The Windows Account Information page of the installation wizard

To place information into the Windows Account Information page, follow these steps:

a. Either manually enter the Account Name and Password values, or click browse ( ) 
for names on the Primary Domain Controller (PDC) to be placed into the Account 
Name text box.

Note: If the account information is entered incorrectly or the account entered 
does not have rights to create the Ultimus services, the following message 
is displayed: The current user does not have rights to create a service. 
Please specify a user with Administrative rights. To resolve this, 
ensure that your account has appropriate local administrator rights 
(as described in the Identifying the Ultimus Windows account section), 
then continue with this installation.
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If you click the browse button beside the Account Name text box ( ), the Select 
Windows Account dialog box appears, as shown in Figure 12.

Figure 12.  The Select Windows Account dialog box

b. Enter the domain for the Ultimus Windows account in the Domain Name text box, 
then click Refresh. All registered users for the selected domain appear in the Domain 
Accounts list box.

If no domain accounts are returned, then either the domain name entered is not spelled 
correctly, or the domain entered is not a PDC. If the account name you are looking for is 
not listed in the Domain Name list, then select Cancel and return to the Windows 
Account Information dialog box to manually enter the value Domain Name\Account 
Name in the Account Name text box.

If the account name you are looking for is in the Domain Accounts list, then select that 
account name, then click the OK button to return to the Windows Account Information 
dialog box. The selected account name returns into the Account Name text box.

c. Enter the correct password in the Password and Confirm Password text boxes.

d. Click the Next button.

15. The Updating System window appears while the installation program proceeds with the rest 
of the installation. Please wait while Ultimus Adaptive BPM Suite is installed.

16. After successfully installing, the computer must be restarted to properly use Ultimus 
Adaptive BPM Suite. Specify whether to restart the computer now or later.
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17. After the Ultimus Adaptive BPM Suite has been successfully installed, the following dialog 
box appears, as shown in Figure 13.

Figure 13.  Ultimus Adaptive BPM Suite installation is complete

18. Click the Finish button.

The installation is complete.

Continue to the Post-installation configuration section to review detailed information on additional 
Ultimus module configurations which may be necessary in your environment.
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Exiting the Ultimus Adaptive BPM Suite 8.3 installation program

You may exit the installation program prior to when any Ultimus Adaptive BPM Suite files are being 
installed. Once files have begun installing, the installation procedure cannot be safely discontinued.

To exit the Ultimus installation program prior to program installation, follow these steps:

1. Click the Cancel button in any dialog box during the installation process. A message 
window appears informing you that the installation is not complete (as shown in Figure 14).

Figure 14.  Aborting the Ultimus Adaptive BPM Suite installation

2. Click the Resume button to continue the installation. Click the Exit Setup button to cancel 
the installation.

Adding additional modules to the Ultimus Adaptive BPM Suite 8.3 
installation

Ultimus Adaptive BPM Suite 8.3 installer may be run additional times on a computer where Ultimus 
Adaptive BPM Suite 8.3 modules have already been installed: other modules may be installed which 
are not already present on the computer. An example of how to use this feature would be that 
Setup.exe could be run again on an Ultimus BPM Studio Client installation to add the Ultimus 
System Administrator module to the same computer.

To add additional modules to the existing Ultimus Adaptive BPM Suite installation, follow these 
steps:

1. Ensure you are logged onto the computer as the same account under which the original 
Ultimus modules were installed.

2. Close all applications, including any applications automatically invoked during Windows 
start-up.

3. Identify the location of the Ultimus License Configuration files on the computer hosting 
Ultimus BPM Server.

4. Double-click on Setup.exe from where the Ultimus Adaptive BPM Suite 8.3 installation 
files have been decompressed, or insert the Ultimus DVD into the DVD-ROM drive. 
The Ultimus installation program should launch automatically; if the Ultimus installation 
program does not launch automatically, then run Setup.exe.
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The Modify or Remove installation page of the installation wizard appears (as shown in 
Figure 15).

Figure 15.  The Modify or Remove installation page of the installation wizard

5. Select the Add button. The Ultimus Locations page appears, as shown in Figure 16.

Figure 16.  The Ultimus Locations dialog box

Within the Destination Folder section, Ultimus Adaptive BPM Suite’s installation directory is 
displayed. Do not change this setting.
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Caution: During the modification, all Ultimus installation files are copied to a 
temporary folder which is always on the system drive. Therefore, there must 
always be sufficient free space on that drive to support the modification 
(approximately 1.4 GB). If sufficient space is not available on the system 
drive, the installation cannot proceed.

6. Use the Browse button in the License Configuration disk section to select the path for the 
Ultimus License Configuration files. The modification will not proceed until the Ultimus 
License Configuration files are located.

7. Click the Next button. The Select Modules page appears, as shown in Figure 17.

Figure 17.  Selecting modules during the modified installation process

Modules which are already installed have a  icon next to their names. Modules which do not 
have this icon may be installed at this time.

8. Select any module not already installed from previous installation procedures, then select the 
Next button.

Tip: If Ultimus BPM Server is among the modules being installed, the Database 
Settings dialog box appears. Refer to the Installing Ultimus Adaptive BPM 
Suite 8.3 section to learn how to specify database application connection 
settings.
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If Ultimus BPM Server or Ultimus FloStation is being installed, the Windows Account 
Information page of the installation wizard appears (as shown in Figure 18).

Figure 18.  The Windows Account Information page of the installation wizard

The account name and password entered into the Windows Account Information page 
overwrites existing Windows account information to register Ultimus services. Therefore, the 
Windows account information used to register Ultimus FloStation in a previous install are 
overwritten by the Windows account information entered during the last modified installation.

The installation wizard installs the selected module(s) at this time.

9. Once the installation is complete, the last page of the Ultimus Adaptive BPM Suite 
installation wizard appears (as shown in Figure 19).

Figure 19.  Ultimus Adaptive BPM Suite modified installation is complete
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10. Select the Finish button.

This completes the modified installation process. Continue to the Post-installation configuration 
section to review detailed information on additional Ultimus module configurations which may be 
necessary in your environment.

Uninstalling Ultimus Adaptive BPM Suite 8.3

Uninstalling Ultimus Adaptive BPM Suite 8.3 is a simple procedure. However, be aware that all 
settings within the Ultimus System Administrator module are deleted once the uninstall is complete. 
Therefore, if customized settings from the Ultimus System Administrator module want to be saved, 
they should be documented and made readily available for when the Ultimus Adaptive BPM Suite 
is reinstalled.

To uninstall the Ultimus Adaptive BPM Suite 8.3, follow these steps:

1. Open Control Panel, then open Add or Remove Programs (or Programs and Features in 
Windows Server 2008 (R2)).

2. From the Currently installed programs: list, locate Ultimus Adaptive BPM Suite 8.3, 
then select the Remove button (or Uninstall/Change in Windows Server 2008 (R2)).

The Ultimus Adaptive BPM Suite Uninstall dialog box appears (as shown in Figure 20).

Figure 20.  The Ultimus Adaptive BPM Suite Uninstall dialog box

3. Click the Next button to confirm Ultimus Adaptive BPM Suite 8.3 is to be uninstalled.

All Ultimus modules on that computer are removed. When the uninstallation is complete, a 
message window appears to inform you that the Ultimus Adaptive BPM Suite has been 
successfully uninstalled.
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Note: Neither the installation directory nor any business processes which you may have 
created are deleted.

4. Click the Finish button to close the Ultimus Adaptive BPM Suite Uninstall dialog box.

Note: If either the Microsoft Excel or Microsoft Word Add-Ins are installed on the 
computer hosting any aspect of Ultimus Adaptive BPM Suite, these Add-Ins must 
be uninstalled before Ultimus Adaptive BPM Suite can be reinstalled.

For more information about how the Microsoft Office Add-Ins and how to install 
them, refer to Installing the Microsoft Office Add-Ins for Ultimus functionality 
section.

Installing Ultimus Adaptive BPM Suite 8.3 SP2

This section outlines how to install Ultimus Adaptive BPM Suite 8.3 SP2.

Note: Ultimus Adaptive BPM Suite 8.3 SP2 can only be installed from Ultimus Adaptive 
BPM Suite 8.3 or Ultimus Adaptive BPM Suite 8.3 SP1. Ultimus recommends only 
installing Ultimus Adaptive BPM Suite 8.3 SP2 when there are no critical or serious 
problems in the existing Ultimus Adaptive BPM Suite 8.3 (SP1) environment.

Refer to the following sections:

• Required files for installation

• Installing Ultimus Adaptive BPM Suite 8.3 SP2

• Uninstalling Ultimus Adaptive BPM Suite 8.3 SP2

Required files for installation

The Ultimus Adaptive BPM Suite installation 8.3 SP2 files are available from the Ultimus Customer 
Console at http://www.ultimussupport.com. Prior to any installation, always verify that 
you are installing the appropriate Ultimus Adaptive BPM Suite version.

Ultimus Adaptive BPM Suite 8.3 SP2 has the same computer prerequisites as Ultimus Adaptive 
BPM Suite 8.3. To review these computer requirements, refer to Verifying computer hardware and 
software requirements section.
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Installing Ultimus Adaptive BPM Suite 8.3 SP2

This section discusses in detail how to install Ultimus Adaptive BPM Suite 8.3 SP2. Ultimus 
Adaptive BPM Suite 8.3 SP2 can only be installed from Ultimus Adaptive BPM Suite 8.3 or Ultimus 
Adaptive BPM Suite 8.3 SP1. Ultimus recommends only installing Ultimus Adaptive BPM Suite 
8.3 SP2 when there are no critical or serious problems in the existing Ultimus Adaptive BPM Suite 
8.3 (SP1) environment.

To install Ultimus Adaptive BPM Suite 8.3 SP2, follow these steps:

1. Ensure you are logged onto the computer with the Windows account which was used to 
install Ultimus Adaptive BPM Suite 8.3.

2. Close all applications, including any applications automatically invoked during Windows 
start-up.

3. If installing Ultimus Adaptive BPM Suite 8.3 SP2 on the computer hosting Ultimus BPM 
Server, then stop all five Ultimus services.

4. If installing Ultimus Adaptive BPM Suite 8.3 SP2 on the computer hosting Ultimus BPM 
Server, then shut down the Ultimus packages in Component Services.

5. Identify the location of the Ultimus License Configuration files which were used to install 
Ultimus Adaptive BPM Suite 8.3.

6. Extract the Ultimus Adaptive BPM Suite 8.3 SP2 installation files. Ensure to extract the files 
to a folder on the local hard drive and not to a folder specified by a UNC path. Once the 
installation files are extracted, double-click on the Ult_Setup_83_SP2.exe file.

Tip: Instead of double-clicking on Setup.exe, right-click the executable, then select 
Run as administrator.

The installation wizard verifies that particular third-party technologies are installed on the 
computer on which Ultimus Adaptive BPM Suite is being installed. If any of these technologies 
are not installed on the computer, then the installation wizard notifies you and cannot continue:

• Internet Information Services (IIS) Manager for your operating system version. Note 
that IIS Manager 7 or higher is installed by the IIS 6 Compatibility role services are not, 
then the installation wizard notifies you that IIS Manager is not installed. To address this, 
install all IIS Manager 7 role services.

• Microsoft .NET Framework 3.5 SP1

• Microsoft Data Access Component

• MMC 3.0 (This is checked at the time when specific suite modules are selected; if a 
module is selected that requires MMC 3.0, then the installation wizard notifies you to 
only select modules which do not use MMC 3.0.)

http://www.ultimus.com/


ultimus.com Installation Guide 61

Installing Ultimus Adaptive BPM Suite 8.3 SP2
Uninstalling Ultimus Adaptive BPM Suite 8.3 SP2

The installation wizard displays the welcome page (as shown in Figure 21).

Figure 21.  The Ultimus Adaptive BPM Suite installation wizard

7. Click the Install button. Please wait while Ultimus Adaptive BPM Suite 8.3 SP2 is installed.

Upon a successful installation, the following dialog box appears (as shown in Figure 22).

Figure 22.  Ultimus Adaptive BPM Suite 8.3 SP2 has been successfully installed

8. Click the OK button.

The installation is complete.

Uninstalling Ultimus Adaptive BPM Suite 8.3 SP2

Uninstalling Ultimus Adaptive BPM Suite 8.3 SP2 does not uninstall Ultimus Adaptive BPM 
Suite 8.3 or Ultimus Adaptive BPM Suite 8.3 SP1 (if the latter is installed).

To uninstall Ultimus Adaptive BPM Suite 8.3 SP2, follow these steps:

1. Open Control Panel, then open Add or Remove Programs (or Programs and Features in 
Windows Server 2008 (R2)).

2. From the Currently installed programs: list, locate Ultimus Adaptive BPM Suite 8.3 
SP2, then select the Remove button (or Uninstall/Change in Windows Server 2008 (R2)).
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The Ultimus Adaptive BPM Suite Uninstall dialog box appears (as shown in Figure 23).

Figure 23.  The Ultimus Adaptive BPM Suite 8.3 SP2 Uninstall dialog box

3. Click the Uninstall button. Please wait while Ultimus Adaptive BPM Suite 8.3 SP2 
uninstalls.

Once Ultimus Adaptive BPM Suit e 8.3 SP2 has uninstalled, the following dialog box appears 
(as shown in Figure 24).

Figure 24.  Ultimus Adaptive BPM Suite 8 .3 SP2 has been uninstalled

4. Click the OK button.
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3
Post-installation configuration

Once Ultimus Adaptive BPM Suite is installed, it may be necessary to further configure certain Ultimus 
modules or third-party applications depending on the environment in which you are running Ultimus 
Adaptive BPM Suite. This section discusses the following post-installation configurations:

• If Ultimus BPM Server is installed on a computer using Windows Server 2008

a. Turning off the User Account control

b. Configuring MSDTC settings for Windows Server 2008 (R2)

c. Changing applicationHost.config to allow database connections using IIS 7

d. Allowing unspecified ISAPI and CGI modules to run from IIS Manager

• If Ultimus BPM Server is installed on a computer using Windows Server 2003 SP2

a. Configuring MSDTC settings for Windows Server 2003 SP2 (32-bit)

b. Configuring IIS Manager 6.0 on Windows Server 2003 SP2 (32-bit)

• Ensuring the Ultimus Isapis Web service extension is allowed

• Setting the Internet Explorer “Enhanced Security Configuration”

• Starting the Ultimus BPM service and the Ultimus FloStation service

• Configuring Internet Explorer to display Ultimus Forms

• Installing the Microsoft Office Add-Ins for Ultimus functionality

Each of these configuration settings is discussed below.

If Ultimus BPM Server is installed on a computer using Windows 
Server 2008

If the computer hosting Ultimus BPM Server is using Windows Server 2008 (R2) operating system, four 
general configuration settings must be made:

• Turning off the User Account control

• Configuring MSDTC settings for Windows Server 2008 (R2)

• Changing applicationHost.config to allow database connections using IIS 7

• Allowing unspecified ISAPI and CGI modules to run from IIS Manager
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Each of these general configuration changes is discussed below.

Turning off the User Account control

User Account control must be set to never notify the Windows account user which was used to install 
Ultimus Adaptive BPM Suite that settings have been made to that computer.

To turn off the User Account control, follow these steps:

1. Go to Control Panel. To do so, go to Start»All Programs»Control Panel.

2. Access User Accounts.

3. Select the Turn User Account Control on or off option (as shown in Figure 25).

Figure 25.  Selecting the “Turn User Account Control on or off” option
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4. Ensure that the Never notify option is set (as shown in Figure 26).

Figure 26.  The User Account Control option is disabled

5. Click the OK button.

Configuring MSDTC settings for Windows Server 2008 (R2)

If the Ultimus BPM environment is distributed across multiple computers (meaning, one computer 
is hosting Ultimus BPM Server and another computer is hosting Ultimus BPM Database and/or 
Ultimus Business Organization Database), then specific post-installation MSDTC (Microsoft 
Distributed Transaction Coordinator) configurations are required in Windows Component Services. 
The MSDTC is a transaction manager which permits client applications to include several different 
sources of data in one transaction, which then coordinates committing the distributed transaction 
across all the servers that are enlisted in the transaction. These configurations are required to ensure 
Ultimus Adaptive BPM Suite properly utilizes MSDTC and executes smoothly.

Caution: The MSDTC configurations outlined below must be performed on the 
computer(s) hosting Ultimus BPM Server and the computer(s) hosting Ultimus 
BPM Database and/or Ultimus Business Organization Database. Failure to 
configure MSDTC on all pertinent computers may result in Ultimus BPM Server 
performing slowly or not perform properly at all.
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To configure MSDTC on a Windows Server 2008 (R2) computer, follow these steps:

1. Open Component Services. To do so, go to Start»Administrative Tools»Component 
Services.

2. Expand the Component Services node to expose the My Computer node.

3. Expand the My computer node to expose the Distributed Transaction Coordinator node 
(as shown in Figure 27).

Figure 27.  The Distributed Transaction Coordinator node

4. From the Name pane, right-click on the Local DTC option, then select Properties (as shown 
in Figure 28).

Figure 28.  Selecting Properties from the My Computer node of Component Services

5. From the Local DTC Properties dialog box, select the Security tab.
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6. Ensure the No Authentication Required option is selected (as shown in Figure 29).

Figure 29.  Ensuring the No Authentication Required option is selected

7. Ensure the Allow Remote Clients option is selected.

8. From the Transaction Manager Communication group, confirm the following settings:

• Allow Inbound: Ensure the Allow Inbound option is selected.

• Allow Outbound: Ensure the Allow Outbound option is selected.

• No Authentication Required: Ensure the No Authentication Required option is 
selected.

9. Click the OK button.

Note: Ensure these MSDTC configurations are made on the computer(s) hosting 
Ultimus BPM Server and the computer(s) hosting Ultimus BPM Database and/or 
Ultimus Business Organization Database.

If any change is made in the Local DTC Properties dialog box, then all 
computers hosting Ultimus BPM Server, Ultimus BPM Database, and/or Ultimus 
Business Organization Database must be rebooted.
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Changing applicationHost.config to allow database connections 
using IIS 7

When using Windows Server 2008 (64-bit) in conjunction with Internet Information Services 
(IIS) 7, applicationHost.config must be changed to properly allow database connections.

To make this revision in applicationHost.config, follow these steps:

1. Using Windows Notepad or any text editor, open applicationHost.config from the 
C:\Windows\System32\inetserv\config\ directory.

2. Look for this line:

<requestFiltering>

3. Change that line to the following:

<requestFiltering allowDoubleEscaping="true">

4. Save applicationHost.config, then close it.

Allowing unspecified ISAPI and CGI modules to run from IIS 
Manager

The Ultimus BPM Server IIS Web site requires unspecified Internet Server Application 
Programming Interface (ISAPI) and Common Gateway Interface (CGI) modules to run.

To allow ISAPI and CGI modules to run from IIS Manager 7, follow these steps:

1. Open IIS Manager 7. To do so, go to Start»Administrative Tools»Internet Information 
Services (IIS) Manager.

2. Select the IIS Manager server node.

3. In the Details pane, from the IIS group, select the ISAPI and CGI Restrictions applet.
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4. From the Actions pane, click the Open Feature option (as shown in Figure 30).

Figure 30.  Opening the ISAPI and CGI Restrictions applet

5. From the Actions pane, click the Edit Feature Settings... option. The Edit ISAPI and CGI 
Restriction Settings dialog box appears (as shown in Figure 31).

Figure 31.  The Edit ISAPI and CGI Restriction Settings dialog box

6. Select both the Allow unspecified CGI modules and Allow unspecified ISAPI modules 
options, then click the OK button.
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If Ultimus BPM Server is installed on a computer using Windows 
Server 2003 SP2

If the computer hosting Ultimus BPM Server is using Windows Server 2008 (R2) operating system, two 
general configuration settings must be made:

• Configuring MSDTC settings for Windows Server 2003 SP2 (32-bit)

• Configuring IIS Manager 6.0 on Windows Server 2003 SP2 (32-bit)

Each of these general configuration changes is discussed below.

Configuring MSDTC settings for Windows Server 2003 SP2 (32-bit)

If the Ultimus BPM environment is distributed across multiple computers (meaning, one computer 
is hosting Ultimus BPM Server and another computer is hosting Ultimus BPM Database and/or 
Ultimus Business Organization Database), then specific post-installation MSDTC (Microsoft 
Distributed Transaction Coordinator) configurations are required in Windows Component Services. 
The MSDTC is a transaction manager which permits client applications to include several different 
sources of data in one transaction, which then coordinates committing the distributed transaction 
across all the servers that are enlisted in the transaction. These configurations are required to ensure 
Ultimus Adaptive BPM Suite properly utilizes MSDTC and executes smoothly.

Caution: The MSDTC configurations outlined below must be performed on the 
computer(s) hosting Ultimus BPM Server and the computer(s) hosting Ultimus 
BPM Database and/or Ultimus Business Organization Database. Failure to 
configure MSDTC on all pertinent computers may result in Ultimus BPM Server 
performing slowly or not perform properly at all.
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To configure MSDTC on a Windows Server 2003 SP2 (32-bit) computer, follow these steps:

1. Open Component Services. To do so, go to Start»Control Panel»Administrative 
Tools»Component Services.

2. Expand the Component Services node to expose the My Computer node. Right-click on 
the My Computer node, then select Properties (as shown in Figure 32).

Figure 32.  Selecting Properties from the My Computer node of Component Services

3. Select the MSDTC tab, as shown in Figure 33.

Figure 33.  The MSDTC tab of the My Computer Properties dialog box
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4. Select the Security Configuration... button. The Security Configuration dialog box 
appears.

5. In the Transaction Manager Communication section, select the No Authentication 
Required option (as shown in Figure 34).

Figure 34.  Selecting the No Authentication Required option

6. Ensure the Allow Remote Clients option is selected.

7. From the Transaction Manager Communication group, confirm the following settings:

• Allow Inbound: Ensure the Allow Inbound option is selected.

• Allow Outbound: Ensure the Allow Outbound option is selected.

• No Authentication Required: Ensure the No Authentication Required option is 
selected.

8. Select the OK button.

Note: Ensure these MSDTC configurations are made on the computer(s) hosting 
Ultimus BPM Server and the computer(s) hosting Ultimus BPM Database and/or 
Ultimus Business Organization Database.

If any change is made in the Local DTC Properties dialog box, then all 
computers hosting Ultimus BPM Server, Ultimus BPM Database, and/or Ultimus 
Business Organization Database must be rebooted.
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Configuring IIS Manager 6.0 on Windows Server 2003 SP2 (32-bit)

Configuring Ultimus BPM Server on a computer which uses Windows Server 2003 SP2 (which uses 
IIS Manager 6.0) requires two configurations:

• Ensuring the Ultimus Isapis Web service extension is allowed

• Setting the Internet Explorer “Enhanced Security Configuration”

Each of these configurations is discussed below.

Ensuring the Ultimus Isapis Web service extension is allowed

When Ultimus BPM Server module is installed on a computer running Windows Server 2003 
SP2 (which uses IIS Manager 6.0), the Ultimus installation program automatically creates a new 
Web service extension named “Ultimus Isapis” (as shown in Figure 35). By default, the status 
of this Web extension is set to Allowed. The Allowed status is necessary to allow remote HTTP 
connections from remote Ultimus modules, such as Ultimus Client and Ultimus BPM Studio 
Client.

Figure 35.  Viewing the “Ultimus Isapis” Web service extension

Tip: The WebDAV Web service extension has no effect on Ultimus BPM Server 
functionality. Therefore, the WebDAV Web service extension may be allowed 
or prohibited.
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Setting the Internet Explorer “Enhanced Security Configuration”

Internet Explorer Enhanced Security Configuration is a function of IIS Manager 6.0 and is 
configured (enabled or disabled) through Add/Remove Windows Components on the 
computer hosting Ultimus BPM Server. When this feature is enabled, IIS Manager 6.0 blocks 
all connections to non-trusted Web sites until the Web sites are individually added through the 
following dialog box (shown in Figure 36).

Figure 36.  Internet Explorer Enhanced Security dialog box

This becomes an issue only when running Ultimus BPM Server on Windows Server 2003 SP2 
and only when viewing content through the Web browser while logged on to Ultimus BPM 
Server.

The above alert appears when attempting to connect to any Web site, including Ultimus 
Web-based components like Ultimus Thin Client or Ultimus Reports. To make Ultimus content 
available, choose the Add button when this dialog box is presented. An alternative is to 
uninstall Enhanced Security.

Starting the Ultimus BPM service and the Ultimus FloStation service

If the Ultimus BPM Server module is installed, the Ultimus installation program also creates the 
“Ultimus BPM” service. The Ultimus BPM service controls many engine functions, such as Ultimus 
Housekeeping. The Ultimus BPM service starts automatically; it does not need to be manually started.

If the Ultimus FloStation module is installed, the Ultimus installation program also creates the “Ultimus 
FloStation” service. The Ultimus FloStation service processes all Flobot tasks. The Ultimus FloStation 
service does not start automatically, and must be manually started.

For details how to manually start the Ultimus FloStation service, refer to Starting the Ultimus FloStation 
service section in Ultimus Adaptive BPM Suite Configuration Guide.
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Configuring Internet Explorer to display Ultimus Forms

Internet Explorer must be configured to display Ultimus Forms. Without this configuration, Internet 
Explorer security prevents Ultimus Forms from displaying because active content is not, by default, 
allowed to run on the computer from which Internet Explorer is being used.

To allow Internet Explorer to display Ultimus Forms, follow these steps:

1. Open Internet Explorer, then select Tools»Internet Options.

2. Select the Advanced tab, then browse to the Security settings.

3. Ensure the Allow active content to run in files on My Computer option is enabled (as shown 
in Figure 37). Ensure to save these settings and restart Internet Explorer before attempting to 
display Ultimus Forms.

Figure 37.  Allowing Internet Explorer to run active content on the local computer

4. Click the OK button.
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Installing the Microsoft Office Add-Ins for Ultimus functionality

Ultimus provides two Microsoft Office Add-Ins that provides some Ultimus client functionality. 
These Add-Ins are referred to as the “Ultimus Office Add-Ins.” The Ultimus Office Add-Ins are required 
on Ultimus Client computers to submit or return Word or Excel forms (regardless of whether parts of or 
the entire Ultimus Adaptive BPM Suite is installed). The Ultimus Office Add-Ins may also be installed 
on computers hosting Ultimus BPM Studio used in form creation and testing. The Add-In for Excel and 
Word are installed separately.

Tip: If you intend to use either the Excel Add-In or the Word Add-In, both need to be 
installed.

Visual Studio Tools for the Office System 3.0 Runtime SP1 (KB949258) must be installed on an Ultimus 
client computer to use the Ultimus Office Add-In.

To install the Add-In for Excel or Word , follow these steps:

1. Ensure that Ultimus Adaptive BPM Suite 8.3 is installed. Furthermore, ensure that Microsoft 
Office Word and Excel is installed and not currently open.

2. Browse to Office AddIns directory (located in the Ultimus Adaptive BPM Suite installation 
directory), then follow these guidelines:

a. Installing the Excel Add-In

1. Browse to the ExcelAddinSetup directory to install the Excel Add-In.

2. Double-click the file setup.exe.

3. From the Microsoft Office Customization Installer, select the Install button to 
install the Ultimus customization (even Microsoft cannot verify the publisher of the 
customization); otherwise, click the Don’t Install button to cancel.

4. Once the customization has completely installed, click the Close button.

b. Installing the Word Add-In

1. Browse to the WordAddinSetup directory to install the Word Add-In.

2. Double-click the file setup.exe.

3. From the Microsoft Office Customization Installer, select the Install button to 
install the Ultimus customization (even Microsoft cannot verify the publisher of the 
customization); otherwise, click the Don’t Install button to cancel.

4. Once the customization has completely installed, click the Close button.

For information how to use the Ultimus Office Add-In, refer to Using the Ultimus Office Add-In 
section in Ultimus Adaptive BPM Suite Configuration Guide.
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Note: If Ultimus Adaptive BPM Suite is uninstalled, then the Microsoft Office Add-Ins 
must be uninstalled before Ultimus Adaptive BPM Suite may be reinstalled on the 
same computer. Both Microsoft Office Add-Ins are uninstalled from Control 
Panel»Add or Remove Programs.
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